Introduction to Block 8

Data Analysis and Presentation of Research Findings

Transforming one’s data gathered from different sources into research findings to be presented in
a written form is a major task of a research process. The two processes are related with each
other. We write only what we know and what we know is only that which we are able to gather by
observing, communicating and interacting in the world around us.

Mills (1959: 5-7) said,

The sociological imagination enables its possessor to understand the larger historical scene in
terms of its meaning for the inner life and the external career of a variety of individuals. It
enables him to take into account how individuals, in the welter of their daily experiences, often
become falsely conscious of their socialpositions. Within the welter, the framework of modem
society issought, and within that framework the psychologies of a variety of men and women
are formulated. By such means the personal uneasiness of individuals is focused upon explicit

troubles and the indifference of publics is transformed into involvement with public issues.

That in brief, is why it is by means of sociological imagination that men now hope to
grasp what is going on in the world, to understand what is happening in
themselves as minute points of the intersections of biography and history within
society
Mills explained why we become curious and how we come to inquire in the social aspects of our being.
Further, Mills (1959: 195) pointed out.
To the individual social scientist who feels himself a part of the classic tradition, social science is

the practice of a craft. ...As a social scientist, you have to ... capture what you experience



and sort it out. .. you must set a file, which is, | suppose, a sociologist’s way of saying:
keep a journal. Many creative writers keep journals; the sociologist’s need for
systematic reflection demands it. Under various topics in your file there are ideas,

personal notes, and excerpts form books, bibliographical items and outlines of projects.

This is how C Wright mills advised sociologists to build their capacity to understand social reality. The
purpose of giving these classical views C. Wright Mills is to point out that the craft of “‘doing sociology”
is multi-dimensional and without undermining collection of data as per methodological
orientation, it is important to also focus on its analysis and presentation. In Block 7 we had units
focusing on field research and formatting and analysis of qualitative research data. We now turn

application of newly available tools of information technology.

Block 8 on Data. Analysis and Presentation of Research Findings has five units. The first four units
deal with the use of information and communication technology in analyzing the data
gathered during social research and then also with the ways of presenting the research findings. The
fifth unit contains guidelines for carrying out a fieldwork-based research project. Let us took at the
content brief of each of the five units of Block 8.

Unit 29 on Using Internet and Word Processor tells us how to understand the basics of the Internet
and its various utilities. It distinguishes between different types of resources available over the Internet
and provides a list of Internet sites that can support social research.

Unit 30 on Using SPSS for DataAnalysis describes how to understand the use of SPSS in
analyzing the data collected from different sources. Next, it tells us how to start and exit the SPSS

programme and also to enter the data into a SPSS Data Editor. In addition, the Unit explains



how to import a data file from the Excel programme and use SPSS for simple statistical analysis of
data.

Unit 31 on Using SPSS in Report Writing explains how to edit the SPSS output tables to suit the
needs of writing a research report. It tells about creating and editing charts for graphic
presentation of one’s data analysis. It spells out how to copy the SPSS edited tables and charts
directly in the research report.

Unit 32 on Tabulation and Graphic Presentation provides a general structure for presentation of
research findings and explains the role of ICT in presentation of research findings. Next, it offers
case studies and steps for report presentation.

Unit 33 on Guidelines to Research Project Assignment contains an overview of the course material
of MSO 002 for building up guidelines for the research work to be undertaken by the learners.
It provides the procedure to follow a research project in terms of its objectives and various
stages of planning, executing the research and finally writing it up and submitting the same at

the Study Centre for evaluation.



UNIT 29 USING INTERNET AND WORD PROCESSING TOOLS

Structure

29.1 Introduction

29.2 Objectives

29.3 What is Internet and How Does it Work?
29.4  Internet Services

29.5 Searching on the Web: Search Engines
29.6 Accessing and Using Online Information
29.7 Online Journals and Texts
29.8Statistical Reference Sites

29.9Data Sources

29.10Uses of E-mail Services in Research
29.11Conclusion

29.12 Further Reading

29.1 INTRODUCTION

In the Units of Block 7 we mentioned that information and communication technology (ICT)
provides a fair bit of aid to a sociologist who is engaged in studying social reality. Unit 29
explains how to use the features of the new technology. This Unit explains what is the Internet
and how it helps a researcher in various ways. It is quite possible that you are already aware of

such inputs and in that case the contents of this Unit would appear to you quite elementary but for



those who are yet to become familiar with this revolution in the way we learn, Unit 29 will be of great
use and help. With the increasing availability of inexpensive personal computers and the State’s
efforts to provide easy connectivity to the Internet at an affordable price, it is hoped that more
and more users in India will be conducting formatting and processing of their researches with

the help of ICTs.

Information and Communication Technology (popularly known as ICT) has revolutionized each
aspect of human life. The well-known abbreviation “www” (or the “World Wide Web”) is an
individual’s gateway to the whole world. Gone are the days when accessing a library used to be
a full fledged event in itself, from seeking permission to getting cards then the long exercise to
find out what one needed. All this was compounded if it required travel to another city. Accessing
libraries and resources outside the country was a dream. Now, all this and a lot more are
available at our desk. With the click of a button, we have all that we need provided we are skillful

in using computers and accessing the Internet.

29.2 OBJECTIVES

After studying this Unit, you should be ableto:

o Distinguish between different types of resources available over thelnternet;
e Build up a list of Internet sites that can support social research;

e Explain use of statistical software for data analysis; and

e Use in your research the Internet and the word processing tools.

29.3 WHAT IS INTERNET AND HOW DOES IT WORK?

The Internet is a network of networks, linking computers to computers. It is the transport vehicle for
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the information stored in files or documents on another computer. It can be compared to an
international communications utility servicing computers. It is sometimes compared to a giant
international plumbing system. However, the Internet itself does not contain the information.
It may not be correct to say that a “document was found on the Internet.” Rather, we should say

that it was found through (or by using) the Internet.

Users of computers may use through the internet one or all of the following internet
Services.
e Electronic mail (e-mail): It permits one to send and receive mail. It provides
access to discussion groups through e-mails.
e Telnet or remote login: It permits one to log onto another computer and use it as
if one were there.
e FTP (or File Transfer Protocol): It allows one's computer to rapidly retrieve
complex files intact from a remote computer and view or save them.
e The World Wide Web (www or “the Web”): The largest and the fastest growing
activity on the Internet.

How does the Internet work?

Every computer connected to the Internet is part of a network. For example, you may use a
modem and dial a local number to connect to an Internet Service Provider (ISP). At work, you may be
part of a local area network (LAN), but you most likely are still connected to the Internet using an
ISP that your institution has contracted with. When you connect to your ISP, you become a part of
their network. The ISP may then connect to a larger network and become part of their network.

As said earlier, the Internet is simply a network of networks.



A typical Internet website address or a URL looks like http://www.ignou.ac.in.In this
name http://denotes that the computer will use Hypertext Transfer Protocol for communicating.
WWW or World Wide Web is the source where this website would be located; ignou
denotes the unique name given to the particular website and ac.in represents the Domain
Name Server which will handle the request and provide the requested website page (for

an example see Box 29.1)

Box 29.1 Example of How Does The Internet Work?

Let us say that you type the URL http://www:ignou.ac.ininto your browser®. The browser
contacts a DNS server to get the IP address®. A DNS server would start its search for an IP address
by contacting one of the root DNS servers. The root servers know the IP addresses for all of the DNS
servers that handle the top-level domains (.COM, .NET, ORG, etc.). Your DNS server would ask the
root forwww.ignou.org and the root would say, “l1 don’t know the IP address for

www.ignou.ac.in but here’s the IP address for the ac.in DNS server.”

Your name server then sends a query to the ac.in DNS server asking if it knows the IP address for
www.ignou.ac.in.The DNS server for the ac.in domain knows the IP addresses for the name servers

handling the www.ignou.ac.in domain, so it returns those.

Your name server then contacts the DNS server forwww.ignou. ac.in and asks if it knows the IP
address for www.ignou.ac.in. It actually does, so it returns the IP address to your DNS server,
which returns it to the browser, which can then contact the server for www.ignou.ac.into get a

Web page.



file:\\www.ignou.org
file:\\denotes
http://www.ignou.org/
http://www.ignou.org/
http://www.ignou.org/

Accessing Internet

Individuals and companies desirous of using Internet access services have a range of options
available, which vary considerably in terms of service quality, and price. There are several free dial-
up Internet Service Providers that provide a basic level of access at no cost. For a company
intending to engage in a substantial amount of e-commerce involving high bandwidth content, a
specialized solution is required at the other end of the range. The company would lease a
line with a certain capacity (e.g. 20Mbps) with the Web site professionally hosted. The
variables to consider are:price, type of connection (dial-up, instant, dedicated), ancillary
servicesavailable (Web site hosting, intranet/extranet provision, services), download speed
(the speed that information travels to you) and upload speed (the speed of information sent
by you).

The most common Internet access procedures are:

. Dial-Up Internet: This is the most commonly used service for individuals, and
for small businesses with e-mail and a Web site. Awide range of operators exist providing
national and regional services,most offering Web site hosting (some included in the monthly, access
fee)and helpdesk services. It requires a modem and a telephone line through which it can
be connected to ISP using unique user identification and password.

In India, the major Internet Service Providers for dial-up connections include VSNL,
MTNL along with other regional level providers. When you purchase an accountfrom any of
these ISPs, you get a unique username and a password, along with a dial up number. When
you connect the modem to the telephone line and dial-up, it asks for the username and
password after which it connects to the ISP from where you can access the Internet.

o ISDN(Integrated services digital network): ISDN allows a customer to have a 64kbps Internet



circuit and telephone/fax line at once or a dial-up connection at speeds of up to 128
kbps. This service is suitable for a business that may have a small number of users
on-line at the same time or needs to transfer files of substantial size (suchas graphics),which would
be too slow over a dial-up connection. In most cases forISDN Internet access, a customer
needs to have an ISDN line installed to the premises.

e Cable modem: While using different technologies, these two products deliver high speed
Internet access on an “instant connection” basis (no dial-up required). The download speeds

vary from 512 kbps to 2 Mbps and upload speeds are of 128-740 kbps.

Specific Advantages of Internet
Compared to traditional sources of information for research, the Internet offers the following additional
possibilities:

e More up-to-date material: Official publications are often publishedonto the Internet before
they arrive in the library, and news services are updated throughout the day.

e Increased access to material: It is absolutely impossible for any single library to hold
paper copies of all the information that isavailable on the Web. Also you have
access to the Internet 24 hours a day.

e Interactivity: Some sites have e-mail discussion forums whereyou can debate issues
and send comments.

Let us complete Reflection and Action 29.1 and assess the level of our understanding of the

help ICTs can provide in social research.



Reflection and Action 29.1

ICT has a vital role to play in social research as it provides access to a large resource of
books, journals, data sets and software for analysis. Find out what type of access to the Internet
is available at your Study Centre. If the Study Centre has no access to the Internet, visit the
nearest cyber cafe in your locality and after discussing with the cyber cafe in-charge, find out
which of the following types of Internet access is available at that café.

e Dial-up Internet;

e |ISDN (Integrated services digital network; and

e Cable modem.

Try to use this facility at least once to find out a few items of information necessaryfor your
research project and then write a note of ten lines to tell whether this method of seeking

information is useful. Mention the problems, if any, faced in the process.

29.4 INTERNET SERVICES

The following description provides us information about the various typesof Internet services

now commonly available to all researchers and the general public.

World Wide Web (www)
The WWW incorporates all the Internet services. You can retrieve documents, view images,
animations®, and videos, listen to sound files, speak and hear voice, and view programmes that

run on practically any software in the world, providing your computer has the necessary hardwareand
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software®to do these things.

When you log onto the Internet using Netscape or Microsoft’s Internet Explorer or some other
browser, you are viewing documents on theWorld Wide Web.The current foundation, on
which the WWW functions, is the programming language called HTML. It is HTML and
other programming embedded within HTML that makes possible Hypertext. Hypertext is the
ability to have Web pages containing links, which areareas ina page or buttons or graphics on
which you can click your mousebutton to retrieve another document into your computer.
This “clickability”@using Hypertext links is a feature, which is unique andrevolutionary about

the Web.

Every document or file or site or movie or sound file or anything you find on the Web has a
unique URL (Uniform Resource Locator) that identifies the thing on the computer, where it is, and its
specific file name. Every Hypertext link on every web page in the world contains one of the URLSs.
When you click on a link of any kind on a Web page, you send a request to retrieve the unique
document on some computer in the world that is uniquely identified by that URL. URLs are like
addresses of Web pages. Awhole cluster of internationally accepted standards (such as TCP/ IP and
HTML) makes possible this global information retrieval phenomenon that transcends political and

linguistic boundaries.

Electronic Mails or E-mail
The most basic and perhaps one of the most useful components of the Internet is the one that
came first---electronic mail (or e-mail), which enables rapid local and global information exchange and

has forever rebranded its much slower manual cousin as snail mail. E-mail is a particularlyeffective
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way of communicating not only with friends but also with business partners and groups of
people you may be working with. It allows for rapid updates on progress and for questions to be
asked and answered in double quick time. Within a decade a host of rival and proprietary
e-mail formats have been devised for use on different computing platforms, which mostly
could not talk to each other. However, as the Internet became more widespread and standards were
implemented to enable different e-mail systems to communicate transparently, the use of e-mail
has remarkably increased. It is not only a key part of internal communication within and
between businesses but is used by virtuallyeveryone who has a personal computer (PC).
UsingE-mail

Now e-mail comes as an integral part of your browser software (for example Outlook
Express with Microsoft's Internet Explorer). On setting up your browser software you are also
asked to establish your connection to the Internet Service Provider (ISP). You will be asked to
enter your e-mail address. The first part of the e-mail address is your choice but itshould be
unique with your ISP; then comes the sign “@”followed by the name of your ISP. Your ISP will
provide you with essential codes to create a new account. The software will also ask you to
provide a name by which you would like to be identified when someone receives anemail from
your account. You will also need to key in your user name and a password agreed on with your

provider.

Sending e-mail is a simple task. You can write your correspondence directly in the email
software or in another word processing programmeand attach it to the e-mail so that the
formatting remains intact. If you want to send your e-mail to several people you can easily do
that by using the carbon copy (cc:) option. If you want to keep the identities of the other

parties receiving the e-mail secret then you can enter their addresses into the blind carbon
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copy (bcc:) field. Once finished, hit the ‘send’button and the e-mail goes from your
computer. You can opt to keep copies of every message sent in the “sent box” which acts as a
good record for future reference or you can begin to organize mail sent and received by
category or project in files within your mail software (see Box 29.2 to understand how e-mail

works).

Box 29.2 How Does E-mail Work?

1. Once you have composed an e-mail and hit the send button, your e-mail programme
sends your mail to the SMTP server where your account is.

2. The SMTP server breaks the address someonelse@theirdomain.com into two parts: someone
else (the account name) and theirdomain.com (the domain). The SMTP server then contacts
the DNS server, and asks for the IP address wheretheirdomain.com is located.

3. The DNS server sends the address back to the SMTP server.

4. The SMTP server then sends the e-mail message to the SMTP server where theirdomain.com
islocated.

5. The second SMTP server delivers the e-mail message to someone else’s account.

6. Someone else logs on to the computer and opens the email software, which then connects
to the server. The software then requests the server to send all e-mail from their account

to their computer.

E-mail is an amazing communications tool once you have mastered it and learnt the basic
rules. However no one likes to receive a spam or unsolicited e-mail unless they have opted

to be part of your network of contacts or potential customers. Spam is a frustrating reality
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on the Internet and those who persist in sending it are not regarded as good net citizens. With
personal or business messages one is advised to read and re-read one’s e-mails carefully
before hitting the send button as misunderstanding and embarrassment can arise quickly

through hasty responses.

29.5SEARCHING ON THE WEB SEARCH ENGINES

Search Engines for the general Web do not really search the World Wide Web directly. Each one
searches a database@of the full text of Web pages selected from the billions of Web pages out
there residing on servers. Search engine databases are selected and built by computer
robotprogrammes called spiders. Although it is said that they “crawl” the Web in their hunt for
pages, in reality they stay at one place. They find the pages for potential inclusion by following the
links in the pages they already have in their database (i.e., already “know about”). They cannot
think or type a URL or use judgment to “decide” to go look something up and see what's there
on the Web about it.

Using search engines

This is the most common form of text search on the Web. Most search engines do their text
query and retrieval using keywords. A keyword can be any word on a Web page. It is important to
use keywords relevant to the topic you are searching. Combinations of words or multiple words can
be used as keywords and the Search Engine will display all the Web pages in its database that
contain most of the keywords used by you. For example, if you wish to find out statistical
software materials that aredownloadablefree from the net, the key words could be “Statistics
Software Free”. Remember some search engines index every word on every page, while others

index only a part of the document. Also, some of the search engines discriminate upper case
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from lower case; others store all words without reference to capitalization.

Keyword searches have a tough time distinguishing between words that are spelled the
same way but mean something different (i.e. hard cider, a hard stone, a hard exam, and the hard
drive on your computer). This often results in hits that are completely irrelevant to your query.
Search engines also cannot return hits on keywords that mean the same but are not
actually entered in your query. A query on “heart disease” would not return a document

that used the word “cardiac’ instead of “heart.”

Most sites offer two different types of searches---“basic” and “advanced.” Advanced search options
differ from one search engine to another, but some of the possibilities include the ability to search
on more than one word, to give more weight to one search term than you give to
another, and to exclude words that might be likely to confuse the results. You might also be
able to search on proper names, on phrases, and on words that are found within a certain
proximity to other search terms.

Many search engines allow you to use the so-called Boolean®@operators to refine your search.
These are the logical terms AND, OR, NOT, and the so-called proximal locators, NEAR and

FOLLOWED BY

e AND means that all the terms you specify must appear in the documents, i.e., “heart” AND
“attack.”
e OR means that at least one of the terms you specify must appear in the documents, i.e.,

bronchitis, acute OR chronic.
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e NOT means that at least one of the terms you specify must not appear in the documents. i.e.,
statistics AND calculator, NOT mathematics.
e NEAR means that the terms you enter should be within a certain number of words of each
other.
e FOLLOWEDBY means that one term must directly follow the other.
e PHRASES: The ability to query on phrases is very important in a search engine. Those that
allow it usually require that you enclose the phrase in quotation marks, i.e., “heart attack.”
e All the search engines have different methods of refining queries. The best way to learn them is to
read the help files on the search engine sites and practice.
Some of the most commonly used Search Engines are:
» Google (http://www.google.com)
Google provides the option to find more than web pages. Using on the top of the search box on the
Google home page, you can easily seek out images from across the Web, discussions that are taking
place on Usenet newsgroups, locate news information or perform product searching. Using the
More link provides access to humancompiled information from the Open Directory, catalogue searching
and other services.
e Yahoo (http: / /www.yahoo.com)
Launched in 1994, Yahoo is the Web’s oldest “directory”, a place where human editors organize
Web sites into categories. In addition to excellent search results, you can use tabs above the search
box on the Yahoo home page to seek images, Yellow Page listings or use Yahoo’s excellent
shopping search engine. Or visit the Yahoo Search home page, where even more specialized

search options are offered.
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e Ask Jeeves (http://www.askjeeves.com)
Ask Jeeves initially gained fame in 1998 and 1999 as being the "natural language” search
engine that let you search by asking questions and responded with what seemed to be the right
answer to everything.
e AllTheWeb.com(http://www.alltheweb.com)
Powered by Yahoo, you may find AllTheWeb a lighter, more customizable and
pleasant“pure search” experience than you get at Yahoo itself. The focus is on Web search,

but news, picture, video, MP3 and FTP search are also offered

e AOL Search (http:// aolsearch.aol.com (internal) and
http:/ /search.aol.corn /(external AOL Search provides users with editorial listings
that come from Google's crawler-based index. Indeed, the same search on Google
and AOL Search will come up with very similar matches.

e HotBot (http://www.hotbot.com)

HotBot provides easy access to the Web’s three major crawler-based search
engines: Yahoo, Google and Teoma. Unlike a meta search engine, it cannot blend
the results from all of these crawlers together. Nevertheless, it is a fast, easy

way to get different Web search “opinions” in one place.

Some other options for Search Engines are:
Teoma(http://www.teoma.corm)
Gigablast(http://www.gigablast.com)
LookSmart(http://www.tooksmart.com)

Lycos (http://www.tvcos.com)
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MSN Search(http://search.msn.com)

NetscapeSearch(http:/ / search. netscape. com)

Open Directory (http://dmos.org)

About.com (http://www.about.com)

Britannica.com(http:/Amww.britannica.com)

Excite (http://www.excite.com)

Won (http://www.iwon.com)

PepeSearch thttp://www.pepesearch.com/)

SearchKing (http://www.aearchking.com)

Complete Reflection and Action 29.2 and find out if you are able to make use of the

ICT aids available at present.

Reflectionand Action 29.2

Find out what type of access to the Internet is available at your Study Centre. If the Study Centre has no

access to the Internet, visit the nearest cyber cafe in your locality and carry out the following

tasks.

e Open an e-mail account if you do not already have one.

e Send an e-mail to your friend who should have an e-mail account and you should know your friend’s
email address.

e Access any of the above-mentioned search engines to obtain some items of information
necessary to your research project.

e Visit a couple ofwebsites, for example one to give you information about the current jobs
available; another one about natural disasters currently occurring all over the world.

After completing the above tasks, write a short note on advantages anddisadvantages of
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using ICT tools.

29.6 ACCESSING AND USING ONLINE INFORMATION

If you are a researcher dealing with any of the social sciences, you would be more interested inusing

the social science research reference sites. Here is some information about them.

Social research reference sites

Using commonly available Search Engines (e.g. Google, Yahoo etc.) is not one of the best and

recommended ways to initiate research through the Internet. Given the limitations of search

engines, there are several other options available where the search results can be far more precise.

The search for Social Research can be classified in the following categories:

Directories and gateways

These provide an entry point for resources collated specifically for a chosen area, which you may

search and browse. Unlike search engines, which automatically collate a list of sites, which match

your search criteria, directories and gateways can provide a more fruitful search for your chosen

topic. Gateways are an excellent place to find high quality Internet sites that can support academic

work. Some of the advantages of using directories and gateways are:

e Gateways are compiled by academic and library experts after devoting considerable
time to scanning the Web for items of interest.

e Gateways are classified in structured and useful ways so that one can access the resources more
easily.

e Gateways are regularly updated.
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A fewexamples of effective gateways for social science researchersare:

e The Social Science Information Gateway (SOSIG) (http: /www.sosig.ac.uk/)This
gateway has links to online papers, discussion lists and courses. It contains Web pages of
several departments and organizations. It has a complete section for social research
methods,including both quantitative and qualitative resources.

e Sociosite: Research Methodology and Statistics (http://
www.pscw.uva.nl_sociosite-/TOPICS/Research.html)-This IS a sociological
information system that provides access to a comprehensive and international listing
of all sociology related resources on the Internet and has a special section devoted to
research methodology and statistics

e Social Science WWW Virtual Library
(http://www.clas.ufl.edu/users/gthursby/socsci/index.htm)-This keeps track of online social
science information as part of the World Wide Web Virtual Library.

Article reference and abstracts databases

One always needs to keep oneself aware of the latest publications in one’s field. The Internet

offers ways to find about these publications via online catalogues of references and abstracts.

While access to some of these sites is free, some require initial membership, which is generally

provided to libraries and institutions. It is likely that your institution (or library) has the

membership of some of these databases and you can access these after obtaining the Password
from your institution/library.

Some popularly accessed databases are:

e Social Science Citation Index (SSU) (http://www.isinet.com/products/ citation/ ssci/)

It contains around 5,000 journals spanning 50 social science disciplines. It covers most

20


http://www.clas.ufledu/
http://www.isinet.com/

of the major journals, which address social research methods dating back to 1973. From a search
you can obtain titles and for over half the author abstracts you can also retrieve titles of citations
references.

e International Bibliography of the Social Sciences (IBSS) (http://Ise.ac.uk/ibss/)
This provides easy access to over 1.5 million references tojournal articles, bookreviews
and monographs from 1951 onwards.

e Sociological Abstracts (http://www.socabs.org/detailsV3/socioabs.html)

It indexes and provides abstracts from many publications coveringsocial research methods.

29.70NLINE JOURNALS AND TEXTS

Most journals in the social sciences have Web sites where both current and backdated research
articles and papers are available for reading and downloading. Gaining access to full text in most of
the online journalsrequires subscription. On obtaining it, a password is provided for
fullaccess. However, most of these journals provide abstracts and/or tableof contents free. There

are a few directories that provide lists and linksto electronic journals. Two such directories are:

e Directories of Electronic Journals (http://gort.ucsd.edu/ejournal/dir.html)---contains
links to electronic journals and newsletters accessthe world.

e The Journal Locator in Psychology and the Social Sciences(http://www.wiso.uni-
augsburg.de/sosio/hartmann/psychojournals.html)--- It lists over 1,600 online
journals and provideslinks to their home pages.

Examples of online journals covering social research methods
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Saciological Research Online (http: / Avww.socresonline.org.uk/---This is an online journal that
publishes high quality applied sociology articles, focusing on theoretical,empirical and
methodological aspects.

Social Research Update (http://www.soc.surrey.ac.uk/sru/sru.html)- This is a
quarterly electronic journal which covers new developments in social research. Each
issue covers different research methods topics spanning qualitative and quantitative

methods.

While full text articles can be browsed free of charge from the online journals mentioned
earlier, the following only provide free access to abstracts and table of contents:
International Journal of Social Research Methodology, (IJSRM) (http://www.tandf. co.
uk/journals/tf/13645579.html---It is a new journal of methodological articles and articles
relating toresearch practice in professional and service settings.

There are also some specialized sites available that archive full texts of paper deliberated or
presented during Conferencesand Seminars. One such site of interest is Education

Online:Electronic Texts in Education and Training (http://www.teeds.ac.uk/educot/).

Library catalogues

Several libraries across the world provide online-access to their catalogues. Library catalogues are
sometimes referred to on the Web as OPACS which stands for Online Public Access Catalogues.
Sometimes these catalogues can only be accessed through passwords, which are available through free

registration on site. Some of the relevant sites are:

The British Library Catalogue (http://blpc.bl.uk/)
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This is an online resource for materials in the major reference and document supply centres of
one of the world's largest libraries.

e Worldwide Index of Library Catalogues(http://www.libdex.com/)More than 18,000 libraries
can be reached through a specialized search from this website.

Assorted useful websites

e Glossary of Research Terms (http://www.mori.com/rmu/glossary.shtml) provides
explanations of topics and technical terms for researchers.

e Social Science Research Methods: Resources for Teachers
(http://www.siu.edu/%7Ehawkes/methhome.html) has links to courses on research
methods and teaching materials as well as other materials of interest.

e The Centre for Applied Social Surveys (CASS) http://www.socstats.soton.ac.uk/cass/)offers a
programmeof short courses on social survey methods, covering all aspects of quantitative survey.

e Index to Theses (http:// www. theses. com/registered_users/simple. html)provides a searchable
database of abstracts of masters and doctoral theses accepted by Universities in Great

Britain and Ireland from 1970 till date.

Reflection and Action 29.3

It is always better to decide on the needs and identify the broad category underwhich the
information necessary for your research project might fall.It helps inpinpointed search and
provides the desired results in relatively lesstime. It is true that general search engines are of

limited help in social research. There are specialized Search Engines created for Social Research.

Try to obtain the information needed by your research project from one of the sources mentioned
above and then write down in one page how you obtained the information and the time you
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spent in getting it and how you are going to use that information in your research.

29.8 STATISTICAL REFERENCE SITES

e The CHEST Directory (http://www.chest.ac.uk/chestdirectory/intro.html) contains a
wide range of software, including those for data and statistical analysis. There are
several other subject specific sites (e.g. foranthropology, psychology) that provide free
access to software required for quantitative and qualitative analysis. Some examples are:

e Computer Assisted Qualitative Data Analysis Software (CAQDAS) Network
(http://caqdas.soc.surrey.ac.uk/)

e Directory of Psychology Software (http: / mwww.psychology. Itsn.ac.uk/)

e Free Statistical Software(http://members.aol.com/johnp71/javasta2.html)

Software for Statistical Data AnalysisComputer software is used to perform any level of
complex statistical analysis with any amount of data available. There are three ways through
which software can be obtained for performing these tests:
1) Purchasing licensed software from the companies
SPSS (or Statistical Package for Social Scientists) is the “most preferred software to carry out any
level of statistical analysis (you will read more about this package and its use in Unit 30). With
SPSS, one can generate decision-making information quickly using powerful statistics,
understandand effectively present results with high-quality tabular and graphical output, and
share the results with others using a variety of reporting methods. All this enables the user to make

smarter decisions more quickly byuncovering keyfacts, patterns andtrends.
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SPSS is highly priced. Generally institutions and organizations purchase multiple user licensed
version of this software and provide access to its studentsandemployees. Purchasing SPSS by
anindependent user is generally not economically viable. However, there are other moderate/low priced
software available for single users. One such software available is “StatCalc”. It simplifies common
statistical calculations, allowing quick analysis of raw data whether you enter it yourself, use a
spreadsheet, or maintain a database. A 30 day trial version of this software is available from their
website (http://www.acastat.com/prod01.htm)
2)Downloading free software from the Internet

There are several committed professionals whose aim is to popularize the use of statistics by
making it simple and affordable. These people have created software that can perform a
wide range of statistical analyses, requiring minimal computer proficiency. The software can
be downloaded from the Internet in about 30 to 90 minutes with reasonable Internet speed. No

licensing is required to use such software.

Such a popular and free statistical software is “Openstat”. This software is similar to SPSS in
appearance and operation. Though not as comprehensive as SPSS, it provides a wide range of options to a
social researcher. It has the capacity to handle large data; it can import from and export data to
other software and can perform all commonly used statistical tests. Someone conversant with
Openstat can effectively use SPSS for all similar applications and vice versa. The software can be
downloaded from the URL (http:/www.statpages.org/miller/openstat/).

3) Online web pages

These are quick solutions to small statistical problems. These may or may not be downloadable

but provide free access. Several of these Web pages provide options for data import. In the
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majority of the situations these work as handy scientific calculators but are certainly
advanced from being simply calculators as they can perform multiple tasks including data entry and
producing charts, etc. Before clicking on to any of these calculators, one should have analyzed the
problem and identified the exact test that is to be applied.
Statistical calculators for descriptive statistics and charts

D Descriptive sampling statistics(http://home.ubalt.edu/ntsbarsh/Business-stat/other
applets/Descriptive.ntm)---This page can calculate some basic descriptive statistics, like mean,
variance, SD, CV, skewness®@and kurtosis.® It can analyze a maximum of 80 numbers. In the
matrix that appears on the web page enter the numbers into each of theColumns on top of the
matrix and hit “Calculate”. All the calculations mentioned below appear. In case a Histogram
is required, provide Class Width and “Number of Classes” in the boxes and hit “Histogramming”. The

histogramwill be drawn that can be selected, cut and pasted in any document for further use.

There are several other such online calculators available on the Internet. To provide some more
examples, the following links may be attempted:

2) Descriptive statistics (mean, SD, SEM, and Cl of mean)
(http://graphpad.com/quickcalcs/clmeanl.cfm)--One can either enter or paste raw data, or enter

mean,SD or SEM, and N to get Class Intervals.

3) StatCalc (http://math.uc.edu/statistics/statbook/java/StatCalc.html)---This
calculator computes summary statistics for onevariable, draw a crude histogram, and sort a
list of values. Given pairsof values it computes the least squares regression line and
Pearson correlation coefficient. It can also perform Chi Square test. The can be either

directly entered or pasted from other worksheets like Excel.
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4) Statiscope (htpp://www.df.Ith.se/~mikaelb/statiscope/statiscope.shtml)---This can be
used for calculating and displaying a large number of descriptive statistics from a set of

numbers that can entered directly into the calculator.

Reflection and Action 29.4
There are several options available for carrying out statistical analysis. This includes online calculators

as web pages that can quickly run the calculation and give results.

There are several statistical packages that can be downloaded free of charge through the Internet

andcan be used for almost all basic statistical tests.

You need to remember that ICT and computer software packages have a limited use in qualitative
data analysis. As all social researches have some component of quantitative data, we suggest that for
analyzing quantitative type of data pertaining to your research project, you try to use the basic tools
mentioned above. Aftermaking an effort to do so, it is important that you mention in your
research project report all the ICT tools that you used in your research. In the evaluationof your

assignment this will be taken into special consideration..

299 DATA SOURCES

There are several websites that provide real data (both raw and tabulateddata). These websites
provide country-specific data. Access to datafrom these websites is generally not free

and membership is required.
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Statistical Data on the Web

(http://www.lib.umich.edu/govdoes/stforeig.html)provides baccess to select socio-economic

data from various countries in the world. A few websites for Indian data are:
e Census Data Online (http://www.censusindia.net/cendat/)
e India Stat.com (http://www.indiastat.com/)

Statistical and research methods
There are several sites dedicated to tutor or guide researchers on Research Methods and the latest
developments in upgrading these methods. of the popular sites in this category are:
SRM (Social Research Methodology)---Documentation Centre
(http://Iwww.niwi.knaw.nl/nlsrm/srm.htm)---contains a searchable database of resources on
research methodology and statistics for social and behaviouralsciences on an international scale.
Sociological Methodology [http://www.blackwellpublishers.co.uk/journals/SM/contents.htm ]
is an annual volume on methods of research in social sciences. Sponsored by the American Sociological
Association, it publishes materials that advance empirical research in sociology and related
disciplines.
Qualitative research
[ http://qrj.sagepub.com/]provides a forum for the discussion of research methods, in
particular qualitative research.
International Journal of Social Research Methodology
(NSRM)[http://www.tandf.co.uk/journals/tf/13645579.html]
Public Opinion Quarterly (POQ)

[ http://www.pog.oupjournals.org/] is the official publication of the American Association

for Public Opinion Research (AAPOR) and focuses on theories and methods
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underlyingopinion research (such as survey validity, questionnaire construction,
interviewingand interviewers, sampling and analytic approaches).

The CASS Question Bank
This question bank provides free access to questionnaires from major social surveys and

associated commentary to assist survey design:

29.10 USES OF E-MAILIN RESEARCH

Usinge-mail as a research tool potentially offers researchers many advantages such as easy
access to world-wide samples, low administration costs (both financially and temporally) and its
unobtrusiveness and “friendliness™to respondents. However, e-mail’s application as a research tool is
constrained by its, as yet, limited and biased population of users(in terms of age, income,
gender and race). Response rates to e-mail questionnaires appear favourable as does the ease of
distribution and response times. Nevertheless, ensuring respondents’ anonymity is virtually

impossible. Using e-mail as an interview tool takes away the conventional constraints of spatial and
temporal proximity between interviewer and respondent and offers the considerable practical
advantage of providing “ready-transcribed” data. However, e-mail interviews suffer from a lack

of tacit communication.

The principal feature of using e-mail as a research tool is its speed and immediacy. An almost
instantaneous dialogue between the researcher and the subject takes place. In particular, electronic
communication sets up a “democratization of exchange” that eludes more conventional
research methodologies. Furthermore, the potential for asynchronous communication that e-

mail offers is an attractive feature when considering its use as a research tool. Subjects are
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not constrained to synchronous communication but can respond when and how they feel
comfortable. E-mails are most commonly used to fill in electronic questionnaire and

conduct electronic interviews.

However, as electronic communication becomes more common, therewill be information
overload and research via e-mail runs the risk of becoming marginalized as a form of
electronic “junk mail”. Unsolicited attempts to gain information via e-mail by genuine

researchers may be ignored by the recipient at the other end of the line.

The proliferation of e-mail, along with the increasing ease of carrying out e-mail and Internet-based
research, suggests that the use of electronic methodologies is likely to increase in popularity in
the near future. However, as said earlier, there remain significant problems in using email in
social science research. Despite the rapid expansion of e-mail, its use as a research toolwill reflect the
demographically based biases of current usage patterns of the medium, in much the same way
that early telephone surveys were also hindered by the clear social class bias resulting from an unequal

ownership of the facility.

Accessing newsgroups and e-mail lists

Suppose you have a question for which you are sure that someone knows the answer, but how do you
find that person? With the Internet you can not only search Web sites for information, but also
communicate with people you may never meet, getting answers to obscure questions that only

they may know.

Newsgroups also referred to as forums have been around almost since thelnternet came into
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existence. They help scientists to post questions (and answers) to each other. Today, newsgroups
resemble virtual coffeehouses, where people get together to discuss subjects of mutual interest.
The only difference is that with newsgroups, the communication is written, not verbal. Newsgroups
revolve around specific topics, such as effectiveness of computer analysis in qualitative research.

You can read what others have written and post your own comments.

There are thousands of newsgroups covering almost every topic, from computers, social issues,
literature and science, to recreation, entertainment, hobbies and current affairs. In newsgroups,
you can find job postings, business and health care advice, announcements about events,
referrals, political and religious discussions. You may download pictures also. See Box 29. 3to

find out how to access a newsgroup.

Box 293 How to Access a Newsgroup

To access a newsgroup, you need a newsreader programme. Most Internet explorers have these
programmes built in. Next, determine which newsgroups interest you and subscribe to
them. Keep in mind that newsgroups were once the only way to have so-called. threaded
discussions, where related messages are grouped together. Today, many Web sites have
discussion group postings. When you are looking for a discussion to join, look at Web sites as

well as newsgroups.

Mailing Lists
Mailing lists use a different strategy. Rather than collecting each messageand displaying it in a central
location, each message is sent as an electronic mail message to every member of the list. The

advantage of mailing lists is that you don’t need to use a separate software programme to
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read messages posted to the newsgroup. The disadvantage is that you can receive dozens,

sometimes even hundreds, of messages per day from a given mailing list.

Newsgroups and mailing lists generate an incredible amount of text each day. Some of them
contain detailed analyses of issues and events by contributors who range from interested members of
the general populace to acknowledged experts in particular fields. If you subscribe to mailing
lists, you can reduce the number of messages you receive each day by using the digest
command, which tells the computer running the mailing list to send you one message containing several
messages. You can learn how to use the digest command by sending a message to the computer
running the list with the word help in the subject line. Remember to send the message to the

computer’s main address, rather than to the list itself.

If you are working on a research project on a current issue or event, you can locate relevant
newsgroups and mailing lists by visiting the Google Group at www.google.co.in or Deja
News Web site at http://mww.dejanews.com or Yahoo's directory of newsgroups and newsgroup
posts at http://www.yahoo.com/News_and_Media/Usenet/Newsgroup_Listings/. To search for
mailing lists dealing with a particular topic, visit the Lisst Web site at http: //www.lisst.comor
the Catalist Web site at http://www.Isoft.com/catalist.ntml. If you want to analyze a list,
discussion, or track back a series of messages, go to Lisst’s Email List Archives Search at

http://www.lisst.com/read/.

To learn more about researching newsgroups, you can view an interactive demonstration. Limiting a
Search with Publication Information, which provides a demonstration of searching the Deja News

Web site. Deja News, located on the Web at http://www.dejanews.com, focuses on the
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contents of newsgroups on the Internet.

Reflection and Action 29.5

In Reflection and Action 29.4 we mentioned that ICT and computer software packages have a limited use in
qualitative data analysis but here is a source that can help you even in the qualitativeresearch aspects of your
project.http://qrj.sagepub.com/ provides a forum for the discussion of research methods, in particular qualitative
research. Try to access this website and find out if it is of any help to your research. Write a short note on your

positive or negative findings.

29.11 CONCLUSION

Provided thata researcher is clear about the needs of research, ICT can be effectively used to gain
information about any research topic in a social science from across the world. With further
advancement in technology, using statistics is no more tedious. It does not require complex
mathematical skills and can be easily handled through various software packages available. ICT
provides excellent and reliable options for managing, storing, retrieving and use of data by several
persons at any given point in time. The exchange of information is swift and fast, and it is
possible to access any amount of information which is physically lying anywhere in the world. ICT
has a lot of potential for use in social research and if used appropriately, can save a lot of time,
energy and other resources. And, as one starts using the Internet, many more potentialities it
has for research become clear. The Internet provides an abundant opportunity to mine information,

data and insights.
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29.12 FURTHER READING

MacFarlane, A. 1977. ReconstructingHistorical Communities. Cambridge University
Press: Cambridge (especially pp. 207-214)
Nie, N. H., C.H. Hull, J. G. Jenkins, K. Steinbrenner and D. H. Bent 1979. Statistical

Package for the Social Sciences. McGraw Hill: New York
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Unit 30
Using SPSS for Data Analysis Contents

Contents

30.1. Introduction

30.2. Starting and exiting SPSS
30.3. Creating a data file
30.4. Univariate analysis

30.5. Bivariate analysis

30.6. Multivariate analysis
30.7. Tests of significance

30.8. Conclusion U | :

Learning Objectives &
It is expected that after going through Unit 30, you will be able to
¢ Understand the use of SPSS in your data analysis

%  Start and Exit SPSS program

>  Enter the data into a SPSS Data Editor

* Import a data file from Excel Program

30.1 Introduction

SPSS (Statistical Package for Social Sciences) computer software program
provides access to a wide range of data management and statistical
analysis procedures. This program can perform a variety of data analysis
including tables, statistical analysis and graphical presentation of data.
Also, SPSS is particularly well suited to sample survey research.

It is assumed here that you have a basic understanding of the basic
concepts and techniques of statistical analysis (see the Units of Block 5
in Book 2). You have also learned how to collect, edit and code data for
analysis. In Unit 30, you will learn how to use the SPSS to perform data
analysis.

You can run SPSS program on a Personal Computer (PC) within the Windows
(95, 98, 2000, XP, or NT) operating system. Since it is a windows based
program, you can use the program without any difficulty and more
interactively like Wbrd, Excel, or PowerPoint programs. The command
instructions given and examples shown in this Unit are Windows based
SPSS version 11.5. '

Please note that Unit 30 does not carry any information in boxes as it
has plenty of graphics to understand the details without the aid of boxes.
For Reflection and Action exercises, there are some straight questions
for you to answer as the reflectic.1 part of the exercise is going to take
place during your reading of the text along with its graphics. It is a good
idea for you to repeat the viewing of these graphics as many times as
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possible and practice using them for carrying out first simpler and later Analysts Contents
more complex tasks.

30.2. Starting and Exiting SPSS

Normally, SPSS program will be located in the Programs folder of your
PC. To start the SPSS,

1)  Click the left mouse button on the Start button located at the
lower left of the screen. A number of items will be listed on the
screen.

2)  Select Programs. The program menu will open.

3) Select SPSS for Windows from the programs menu and then select
SPSS 11.5 for Windows from the SPSS menu. Click and release
the mouse button. Symbolically, these actions are shown as: select
Start>Programs->SPSS for Windows->SPSS 11.5 for Windows
command from the Start button of your PC. (Throughout this Unit
and Unit 32, we will be showing the symbol>to indicate the
director (steps)you have to move your cursor with mouse.).

. Windows XP Professiom?

; gmt :9 wcwsafrw
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" Figure 301 | SPSS for Windows

4)  After a few moments, you will see the Data Editor window dialog@
box along with a SPSS for Windows menu dialog box asking you
“What would you like to do?”.

Column Head Menu Bar Togl B

Active Cell

Figure 30.2 SPSS for Data Editor 2954
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Exit SPSS Data Editor: Whenever 'you have finished using SPSS and- want.
to quit it, then select File?Exit command on the menu bar.

30.3 Creating a data file

Normalty, the first thing you would like to do is to create a data file. For
this, check mark on the box and then click OK button on the’
SPSS for Windows menu dialog box. The menu dialog box disappears
from the screen leaving the Data Editor on the screen.

Data Editor: The Data Editor helps you:

1)  To enter a series of data you have in a specified format required
for data analysis.

2)  Open an existing file.
3) Edit the data.
4)  Converting other data files into SPSS data files.

5)  Will be active throughout your- session of using SPSS data entry and
data analysis.

The Data Editor looks like a worksheet made up of a series of rows and
columns. The intersection of a row and column is called a cell. The cells
may contain numbers or text. Each column will contain information/
data for each variable. Similarly, each row contains information/data
for each case.-

The first row of the cells located at the top of each column is shaded and -
contains a faint Var. These cells contain the names of variables. Similarly,
the first shaded column contains faint numbers (1,2,3,...). These are
called case numbers.

The Data Editor dialog box ctontains a Menu bar at the top of the window.
The menu bar identifies broad categories of SPS5’s features called
commands. This menu bar helps you in defining and selecting commands.

MEE=]

Figure 30.3 Menu bar and Tool Bar of:SPSS Data Edltor

The Toolbar is below the menu bar and ‘allows you to quickly access basic
SPSS commands. By-clicking on the respective buttons you can access
some commands which will interest you quite often.

Observe the cell at the intersection of row1 (Case 1) and columni (Var
1) with a heavy border. The heavy border cell indicates that the cell is an
active cell. You-can enter or edit data in the cell. You can activate any
cell in the worksheet by S1mply pomtlng the mouse cursor® at it and
clicking once. '



S Untitled - SPSS Data Editor

Figure 30.4
Untitiled SPSS Data View

There are two views available in the Data Editor: Data View and Variable
* View. In the Data View, you can see the data the way you have typed. In
the Variable View, you can see the properties of each variable defined.
To access these views click on the respective buttons located at the left
bottom of the Data Editor screen.

L T\ Dot View [ Voriabiie Vew
" Figure 30.5 Untitiled SPSS Variable View
- Entering data into Data Editor

As you have learned earlier, your data may contain a number of variables.
EX‘amples of variables are sex (male or female), marital status (married,
unmarried, widowed, etc.), income, attitude (likes, dislikes, etc.), a
score, etc. Again, for each variable you may have a humber of observations
called cases. You have also learned in an earlier unit how to assign the
codes to the qualitative data. For example, you have a data set containing
information of 30 people on sex distribution, age, marital status, and
income. You also assigned the following codes for the data set.

Sex distribution: male = 1, female = 2

Age in years | ,

Marital status: married = 1, unmarried = 2, widowed = 3
Income in Rs.

The data you might have collected may look like as follows:

Table 30.1

Data Set by Sex, Age, Marital Status and Income for 30 Persons
Case Number Sex Age Marital Status Income(Rs.)

1 2 24 1 150000

2 1 52 1 345000

3 2 65 3 45000

4 1 35 3 245000

5 1 42 1 23000

6 1 25 1 670000

Using SPSS for Data
Analysis Contents
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7 2 23 2 345000
8 2 63 1 156000
9 1 41 2 65300
10 2 48 1 150000
11 1 34 2 354000
12 2 55 3 23000
13 1 28 1 452000
14 1 43 2 120000
15 1 23 2 456000
16 2 65 1 765000
17 2 67 3 235000
18 2 32 2 54000
19 1 30 2 200000
20 2 25 2 180000
21 1 47 1 210000
22 2 36 3 350000
23 2 70 1 42000
24 1 67 3 175000
25 2 24 2 45000
26 1 32 1 234000
27 1 20 2 125000
28 2 25 1 36000
30 2 40 3 560000
30 - 2 45 1 234000

The process of data entry into the Data Editor involves four basic steps:

1) Define variables

2) Define labels

3) Define missing values

4) Enter the data into the cells

We will explain these steps with the help of the data given in our earlier
example. For this move your cursor to the left bottom of the Data
Editor and click on Variable View button, if the Data Editor is not in the
Variable View.

Step-1: Define Variables: You need to define a variable to name it,
specify the data type (qualitative, quantitative, number of decimal places,
etc.), assign labels to the variable and data values, define missing values,
and specify levels of measurement (nominal, ordinal, interval/ratio scale). .
In addition, you can also define the column format. For this, B

1.  Activate a cell in the first column by clicking on it.

aabie Mew { button. The grid will change to a new
format as shown below. For each variable you create, you need to
specify all or most of the attributes described by column headings.

3. Activate the first .cetl -in row 1 under Name column heading to



change the variable name. Type the name of the variable say Sex
and then press enter key. Observe that the variable name Sex
replaces with the default variable name Var and in the other cells
of the first row the default properties of the variable will appear.
o B e e T el
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Flgure 30.6 Changes in Data Grid and Data Variable
Remember that a variable name can have a maximum of 8 characters
containing only letters or both letters and numbers. The first character
of a variable name should start with a letter when it contains numbers.
There should not be any special characters (like &, 7, !, ‘,*) in the
variable name. Also, in the same data file no two variables should have
the common names. |

4) To change the type of a variable, move the cursor to the second
cell of the first row under Type column heading. A small grey
button marked with three dots will appear. Click on it. The Variable
Type dialog box appears on the screen. Notice that Numeric is
the default Variable Type. If you have only numeric values for that
variable (say Sex variable) check mark the Numeric box. You can
enter the width of the number (the default width is 8 characters)
in the Width text box. Sometimes you may need to enter numbers
with  decimal

' places. Enter the

VYariable Type

number  of oM oo [=17
. . ™ Conea mﬁ
decimal places in . , . Comeal g
: A Do [
the Decimal ¢ susilic vnsion e g g
Places text box. ¢ Bue
The default 7 Dol |
setting is 2 ¢ Dsemoeey
T Suiny

decimal placeé. If
your data
contained only integer values, type 0 in the Decimal Places text
box. If you have a variable string characters (like names of people,
places, etc.), check-mark the String button in Variable type dialog
box and enter the maximum number of characters that particular
string variable can hold. Similarly, other data variable types such as
date, currency, etc., can also be defined.

Figure 30.7 Variable Type

5) Specify the level of measurement for the variable (for example,
Sex is a nominal variable). By clicking the cell under Measure
column heading.

Step-2: Define Labels: Now you can assign the text labels to the coded
values of the variables. A variable label is a longer description of the

Using SPSS for Data
Analysis Contents
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variable that can be included in the variable name you have defined
earlier: This may be necessary since the variable name is restricted to
only 8 characters and at later stages to understand the characteristics of
that variable. To define labels,

1)  Type the name of the label (say Sex distribution of persons) in the
cell under Label column heading.

2)  Move on to the cell under Values column heading. Click the grey
box with three dots. Value Labels dialog box appears on the screen.
Type the numerical value assigned for the label under Value text
box and type label name for that value under Value Label text
box. For example, you may type 1 in the Value text box and Male
in the Value Label text box. To add the label, click Add button.
Again type 2 in the Value text box and Female in the Value Label
text box and then click Add button.

Value Labels

Figure 30.8
Variable
Labels

3) Continue this process until you add all the values and the respective
labels. ’

4)  Click OK button to close the Value Labels dialog box..

Remember that you need to define Value Labels only for categorical
data. For the continuous data this is not required.

Step-3: Defining Missing Values: Sometimes, your data may contain
missing responses for a variety of reasons. Assign a missing value to the
variable if necessary. For example, if the Sex category of a person is not
available, you may assign the value 9 to indicate the missing value. The

" missing value indicates to SPSS that the response is not available and
_should not be included in the data analysis. To define the missing values

to the variable,

1) Click on the cell under Missing column heading. The Missing Values
dialog box appears on the screen.

Missing Values

Figure 30.9"
Missing Values

£



2) If there are no missing values in the variable, check mark No
missing values button. Otherwise check mark Discrete missing
values button. You can type a number assigned by you as Missing
value. For example, you may assign 9 if Sex category of a person
is not available. If you have check marked for missing values, type
the assigned missing vatue (say 9) in the text box.

3)  Click OK button to close thé dialog box.

Remember that the missing values you have assigned for-a variable are
pr?sent in their respective positions in a data file.

You can also specify the width of each column in the cell under Column
column heading and the alignment (Right, Left, and Center) in the cell
under Align column heading. Specify the type of measure in the cell
under Measure heading.

Figure 30.10
Specifying under Measure

Now you have defined all the information for the variable. Move on to
the second row (to define ‘age’ variable), the third row (to define
‘marital status’ variable), ...etc. to define the re_ét of the variables in
that order. '

wa im i
Diaita sttt ), Mamest).. ! Wgw  Momine
?msnlh& Miowe o i m& Seain

§

Flgure 30.11(a) Deflmng all the vanables

you have defined all the variables, you may like to see the generated

variable definitions. For this, select Utilities->File Info command on the
menu bar. This will generate file information in the output w1ndow that
can be printed if you need for future reference.

> File Information
List of variables on the worklng flle

Name

Position

SEX Sex distribution of persons

1) Measurement Level: Nominal -

Column Width: 8 Alignment: nght
Print Format: F1
Write Format: F1
Missing Values: 9

Using SPSS for Data
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AGE
2)

MARITAL
3)

INCOME
4.

Step -4: Entering the Data into the Cells:

Value Label
1 Male
2 Female

Age in years

Measurement Level: Scale

Column Width: 8 Alignment: Right
Print Format: F1

Write Format: F1

Missing Values: *

Marital status

~

Measurement Level: Nominal
Column Width: 8 Alignment: Right
Print Format: F1

Write Format: F1

Missing Values: 9

Value Label

1 . Married

2 Unmarried
3 Widowed

Income in Rs.

Measurement Level: Scale

Column Width: 8 Alignment: Right
Print Format: Fé

Write Format: Fé6

Missing Values: 99

o W N =l R R RN e R
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Entering Values for Each Variable

Figure 30.11(b)

Once all the variables for
wp’ T wwbi  wowe [ 1 your data file are defined,

the data can be directly
entered into the cells. For

"z | this, first change the view
BARR to Data View by clicking the
"y | Data View button.

R
B 1) Click on cell 1 of the

(Sex) variable to
activate the cell.

Type the value of the
variable (say ‘2’) and
then press Enter key.

Observe that now number
‘2’ appéars in cell 1 and cell
2 (the cell below cell-1)
becomes active.



-
~4

3) Type 1 and press Enter key. This indicates that the value for case
of the sex variable is also entered. Continue this procedure until
all the values of the 30 cases are entered for sex variable.

Using SPSS for Duta
Analysts Contents

4) Activate the case 1 cell below Age varlable (column) and start
shle mesepedme il

entering values for that variati&, :
you enter the data for all cases and all vanables ng a data file .

Once you have entered the data, it is a good practice to save the data in
a file. This witl avoid not only repeating the data entry but also for all
future uses of your data. §SS distinguishes between two types of files:
data files (with extension .sav) and output files (with extension .spo).
The data files contain the data you have entered. The output files contain
the output of the data analysis you have performed. You need to save
these files in case you may need them for future use.

To save a data file,
1)  Select File->Save' As... command from the menu bar. The :Save
Data As dialog box appears on the screen.

..I.___-._ - —

ol |

- eom e e e S
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|:lgure :30.12 Saving a Data File

2)  Select the drive and i’o_lder where you are interested that your file
should be lpcated.

3) Type the file name in the text box under File name box. Click
Save button.

Importing a data file from Excel worksheet
Often you might have entered data-in an Excel worksheet and want to
use the same data set for analysing the datausing SPSS &S caneasily | %  ayp3¢
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open an Excel data file and some other types of data files. To open an
Excel data file,

1) Select Start->Programs Microsoft Excel command-from the Start
button on your PC screen. In a few moments the Excel worksheet

dialog box appears on the screen.

”

2)  Select File>Open... command from the menu bar. The Open
File dialog box appears on the screen. Select the drive and folder
where the data file is stored. Select (or type) the file name and
click OK button. The Excel data file will open as shown here.

Observe that the variable names are at the top row. Let us assume that
the worksheet has been saved as Excel (with extension .xls) file called
Profile.

3) Select File->Open->»Data... command in the SPSS Data Editor
dialog box. The Open File dialog box appears. Choose the
appropriate directory and folder in Look in File of type box
Select the file name Profile.xls in File name box.

2 Microsoit Bxeet - Book1

‘@) gk G Yow Juat Fgwat Jook Data Wdww feb
DBHIUSRY SRB-¢ o- - @
Tmhm _-m-l!nﬁii\ﬁxg

hd BB |

i B C | D  E L

Ps.z Age witd  [lncome

2 24 1 150000

it 52 1 345000
,,,,,, 2 m

1 g ﬁ 245000

1 2 1 2000

1 25 1 i670000

7] 3 2 345000

7 1 156000

1 ~Ja 2 165300

2 48 1 1350000

1 34 2 354000

7 55 3 23000

1 28 1 452000

Figure 30.13 Microsoft Excel - Book1

Observe that the variable names are at the top row. Let us assume that
the worksheet has been saved as Excel (with extension .xls) file called
Profile.

4)  Select File->Open?Data... command in the SPSS Data Editor dialog
box. The Open File dialog box appears. Choose the
appropriate directory and folder in Look in box. Choose the
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Excel (*.xls) in the File of type box. Select the file name
Profile.xls in Filename box.

Flesdbpe  [SPSS T

Figure 30.14 Open Files

5) Click Open tab in the Open File dialog box. The Opening Excel
Data Source dialog box appears on the screen. If your Excel file
contains variable names, check mark Read variable names from
the first row of the data box. If you leave the Range box blank,
SPSS will read all the available data in the Excel worksheet. If you
wish to read only some rows and columns theh type a range. For
example, you may type A1:D30 to select first 4 columns (A,B,C,
and D) and 30 rows (1 to 30). Click OK button to close the Opening
Excel Data Source dialog box and return to the Data Editor dialog
box. Observe that the data is in SPSS Data Editor. Save the SPSS
data file. ‘

Opening Excel Data Source

D:\jain\Book11.sde

I Read vasiable names fom the first sow of data,

Wodsheet [Sheet! ATE31] e R
Range: !, '
oK . Cancel | Hep |
o |

Figure 30.15 Opening Excel Data Source +105
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| .
Research Findings | Answer the following two questions after going through the text above and :
— | viewing the graphics. The idea about answering these questions is to make sure
—
—— that you have understood the procedures. :
| 1.  Explain brie i ing a data file. »\L\

2. Differentiate between SPSS Data Editor and Output SPSS Viewer.

30.4 Univariate analysis

Data can be analysed in a number of ways. You can present the data in a
simple frequency table or use statistical techniques. For the analysis of
data, the data file should be opened first. If the data file is not already
open, select the File->Open command from the menu bar. The Open
File dialog box appears. Choose the file location and SPSS data file name
and click OK button. The data may now appear in the Data Editor screen.

SPSS offers several tools to analysé ihe data. The tools are selected from
the Analyze command on the menu bar. In this section, you will learn
how to generate frequency tables and calculate the univariate statistics.

Remember that you can compute the same statistics in SPSS using
alternative commands.

Frequency tables | 4 - .
To generate the frequency tables,

1)  Select Analyze->Descriptive Statistics—)Fi'equencies command
from the menu bar. The Frequencies dialog box appears on the
“screen with two large boxes for variables selection/deselction.

Observe that the left box contains a list of variables for which
data has been entered. On the right side, there is an empty box
for the variable(s) that you want to include in the analysis.

2) In the left side box, select the variable to generate a frequency
table by clicking the mouse on the name of the variable. Click the
arrow between the two boxes. The selected variable appears
on the right side box. Follow these steps till all the variables you
want to include for the data analysis appear on the right side

box.

' Figure 30.16
Frequencies

106 K




3)

4)

When the first variable is moved to the right side box an E:] arrow
in the opposite direction appears between the two boxes. If you
commit a mistake by selecting a wrong variable, click this arrow
to return the variable to the original list.

" Remember that this Frequencies tool is appropriate only for the

categorical data (like Sex and Marital status in our example).
Therefore, do not select any continuous variables (like in Age and
Income in our example).

When you have selected all the variables, you want to include for
data analysis, click the OK button. In the Output SPSS Viewer
window, you should now see the output shown below.

- Oufputd. - SPSS ¥

Mo GA Vew beet Powat 3

AMN%M

%Q@@Q@f

Figure 30.17 Output SPSS Viewer

Frequencies
Find below two tables (Table 30.4 and 30.5 on Sex \Distribution of Persons
and Mantal Status, respectively). '

- Table 30.2 Sex\Distribution of Persons

Statistics
Sex Distribution of Persons | Marital Status
N Valid . 30 30
Missing ' : 0 0

Frequenciés table

Table 30.3 Marital Status

Sex distribution of persons

Cumulative

Fequency | Percent | Valid Percent| Percent

Valid Male 14 46.7 46.7 46.7
Female 16 53.3 . 53.3 100.0

Total 30 100.0 100.0

Using SPSS for Data
Analysis Contents
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Research Findings Marital status
Cumulative
Fequency |Percent | Valid Percent Percent
Valid Married 13 43.3 43.3 43.3
Unmarried 10 33.3 33.3 76.7
Widowed 7 23.3 23.3 100.0
Total 30 100.0 ~100.0

Observe that the tables contain all the information you want. Also, you
have information on the missing cases for each variable. You also have
three types of percentages: one for all the cases including missing cases
under the heading Percent, the second one for only valid cases under
the heading Valid Percent, and the third gives cumulative percentage
under the heading Cumulative Percent.

Printing/Saving Output: Now you may want to print on paper or save in
a file all or part of the output available in the Output SPSS Viewer
window. :

1)  To save the output in a file, follow the instructions given at saving
a data file.

2) To print all the output click anywhere in the Outline pane located
on the left side of the screen. Select File=>Print command from
the menu bar. Click OK button.

3) To print a part of output, move the cursor to the end of the
portion you want to print. Press the Shift key on the keybord and
click the left mouse button. Observe that the selection is highlighted.
Select File->Print command from the menu bar. Click OK button.

Recode Data: you may want to recode your data for a variety of reasons.
For example, the data values for the variable Age are continuous. Now
you may want to group them like,

Old value New Value

Less than 19
20-30

30-39

40-49

50-59 Table 30.5

60 and abave 6 Data values

To recpde a variable, select Tranform->Recode~>into Diffrent Variables

command from the menu bar. The Recode into Different Variables
dialog box appears on the screen.

W=

Select the variable you want to recode into different variables in the left
side box. Transfer this variable to the right side box using arrow tab that
lies between the two boxes. Type the name of the variable in the Name
text box and label name in the Label text box.

o
o5
-h
o
[+
o
3
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Figure 30.18 Recode into Different Variables: Old and New Values

Press the Old and New Vatues button in the Recode into Different
Variables dialog box. The Recode into Different Variables: Old and
New Values dialog box appears.

~ Check mark the Range button. Type the first range of values in the
~ boxes under Range. Check mark the Value button under New Name
heading. Press Add button to define Old and New values. Press Continue
button to close the Recode into Different Variables: Old and New Values
dialog box and return to the Recode into Different Variables dialog box.

Recade into Different Yariables: Old and New Yalues

f‘ ng& :
F“‘M“““W fernigh bt
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Figure 30.19 Recode into Different Variables

If you have more variable(s) to redefine, continue these steps for each
variable. Otherwise press OK button to close the Recode into Different
Variables dialog box.

Univariate® statistics
For each variable of your data set, you can calculate:
a) Measures of central tendency: Mean, Median, and Mode.

b) Dispersion: Standard deviation, Variance, Range, Standard Error
of Mean, etc. ' +1094%

t
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c) Distribution: Kurtosis and Skewness

Remember in SPSS there are some restrictiohg, on the choice of measures
of central tendency (Mean, Median, and Mode) that can be calculated on

. any data set. The choice of Mean, Median, and/or Mode is restricted by

the level of measurement of a variable you have defined. If the level of
measurement for a variable is nominal, you can calculate only mode. |If
the level of measurement of a variable is ordinal then you can calculate
Mode and/or Median. If the level of measurement of a variable is
interval/ratio, you can calculate Mode, Median, and/or Mode.

To calculate the univariate statistics,

1)  Select Analyse-> Descriptive Statistics»Frequencies from the
‘ menu bar. The Frequencies dialog box appears on the screen.

2) Transfer the variables on which you want to perform the data
analysis from left side box to right side box (as you have done for
frequencies analysis earlier).

ﬂF mmm

Figure 30.20 Frequencies Analysis

3) If you don’t want to display frequencies, remove the check mark
in Display frequency tables button by clicking. The SPSS for
Windows dialog box appears asking you to confirm. Click OK button
te close that w1ndow. '

\DS§ mr W mdmw:

Flgure 30.21 Closmg SPSS for Windows

4) Click on the Statistics... button in the Frequencies dialog box. The
Frequencies:Statistics dialog box appears on the screen. :



5)  In the area under Central Tendency, check mark the appropriate
button to calculate Mean, Median, and/or Mode.

6) In the area under Dispersion, check mark the appropriate buttons
to calculate Standard deviation, Variance, Range, Standard error
or Mean, etc.

7) Inthe area under Distribution, check mark the appropriate buttons
to calculate Skewness and/or Kurtosis.

ifrgquencies: Stotistics
- PraniinVais ft**ﬂﬁﬂﬂnwﬁb ﬂ||||||
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Figure 30.22 Frequencies Statistics

8) Click on Continue button to close the Frequencies: Statistics
dialog box.
9) . Click on OK button in the Frequencies dialog box to close it.

Observe that now the output IS Descriptive Statistics.

Table 30.6 Statistics

Age in Years |Income in Rs.

N Valid ' 30 ' 30
Missing 0 0

Mean 40.83 234810.00
Std. Error of Mean ; ' 2.891 35206.370
Std. Deviation 15.836 192833.232
Variance ‘ 250.764 37184655414
Skewness Xy 1.182
Std. Error of Skewness , .427 .427
Kurtosis ~1.012 1.059
Std. Error of Kurtosis .833 .833

Remember that you should opt for only appropriate statistics. For
example, there is no meaning in opting for Mean of a sex Variable since
tthere is nothing like mean of a sex distribution.

Using SPSS for Data
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Reflection and Action 30.2

You have just finished reading about univariate analysis in which you worked on
frequency tables and univariate statistics. In the light of this information answer
the following questions.

l

|

I

I

| < What is the command on the SPS5 menu bar to perform frequencies data
| analysis?

| < Once the data has been coded and entered into the SPSS Data Editor, is it
| possible to recode the data? If yes, what is the command to recode?

|

|

I

**  You have defined the level of measurement of a variable as ordinal. Is it

possible to calculate all the measures of central tendency for this variable
using SPSS. Name the central tendency measures you can calculate.

30.5 Bivariate® Analysis

Often, you may be interested in comparing two sets of data or Variables
to explore the relationship between two Variables. In this Section, you
will learn how to cross-tabulate the data, coefficient of correlation,
linear regression, and coefficient of variance to compare two variables.

Cross-tabulation of data

To capture any possible relationship between two variables measured
with categorical data, you may use bivariate table, which is also known
as cross-tabulation. To cross-tabulate two variables follow the steps
given below.

1)  Select Analyse?Descriptive Statistics?Crosstabs... command from
the menu bar. The cross tabs dialog box appears on the screen.

2)  Click on the Variable in the source list (from left side box) that will
form the rows of the table. Shift this Variable to the box under
Row(s) using arrow key.

3) Similarly, shift the variabte that will form the columns of the table
from source list to the box under column(s).

St - Bl Y- ¢
W Age jnyoars [age| B A TR A 1
P lsoere 7 Br. come. Piﬂ“ﬁﬂmﬁm Paste

T Y TSP,

Figure 30.23
Crosstabs




4)  Click OK button. You will find the table in the Output viewers

window.
Crosstabs
Table 30.7 Case Processing Summary
Cases
Valid Missing Total

N |Percent| N [Percent| N [Percent

Sex distribution of 30 {100.0% | 0 0% 30 | 100.0%

persons Marital status

Count

Table 30.8 Sex distribution of persons’ Marital status Crosstabulation

Marital Status

Married |Unmarried | Widowed| Total
Sex distribution Male 6 6 2 14
of persons Female 7 4 5 16
Total 13 10 7 30

- Sometimes, you may be interested in calculating the row/column/total
percentages in a table. For this, click on Cells...tab in the cross tabs
dialog box before step-4 above. The Crosstabs: Cell Displays dialog box
appears on the screen.

Crosstabs: Cell Display

~Peicentages——  r~ Residuale
MRw | T Unstandedized
" Coumn T Standwdzed
M Tod © | T Ad sanderdzed

i

~ Figure 30.24 Crosstabs: Cell Display

Check mark the appropriate (Row, Column, and/or Total) button under
percentages area. Click continue button to close the Crosstabs: Cell

Using SPSS for Data
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Display dialog box. Click Ok button on the Crosstabs dialog box, to view
the output (see Table 30.9 and Table 30.10).

Crosstabs
Table 30.9 Case Processing Summary: Output
Cases
Valid Missing Total

N [Percent{ N [Percent| N |Percent

Sex distribution of 30 |100.0% | 0 .0% | 30 | 100.0%

persons* Marital status

- Table 30.10 Sex distribution of persons *Marital status
Crosstabulation: Output

Marital status
. " |Married|Unmarried/Widowed! Total
Sex Male Count 6 6 2 14
distribution % of Total| 20.0% | 20.0% 6.7% | 46.7%
of persons Female Count 7 "4 5 16
% of Total| 23.3% [ 13.3% 16.7% |.53.3%
Count 13 10 7 | 30
% of Total| 43.3% | 33.3% 23.3% [100.0%

Bivariate statistics ‘
The statistical tools you often use to compare two Variables may be the
coefficient of variance, correlation, and linear regression.

Coefficient of variance: As you are aware, the Coefficient of Variance
(CV) is the standard deviation expressed as a percentage of the mean.

Standard deviation
V= ————— X100.

Mean
Unfortunately, SPSS does not have a command to complete the Coefficient
Variance for a varidble in a data file. What we advise you is that you
should calculate the respective Mean and Standard deviation of a Variable
using the Descriptive dialog box as explained earlier and then calculate

the CV by hand which is very simple.

Correlation coefficient: There are two types of correlation coefficients:
Pearson’s correlation coefficient and Spearman’s rank correlation
coefficient. The Pearson correlation is appropriate and applicable when

~ you have interval/ratio data. The Spearman rank correlation coefficient

is applicable when you have two ordinal scales with a large number of
values or one ordinal and the other interval/ratio scale.

To compute the appropriate correlation coefficient for your data set,

follow the instructions given below.

1)  Select Analyse->Correlate->Bivariate... command from the menu
bar. The Bivariate Correlations dialog box appears on the screen.

2) Select the variables by shifting from left side box to the box under
Variables area. '
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Figure 30.25 Bivariate Correlation

3) Check mark the appropriate (Pearson, and/or Spearman) button
under Correlation Coefficients area to select the type of correlation
coefficient. '

4) If you want the associated tests of significance, check mark the
appropriate (Two-tailed or one-tailed) button under Test of
Significance area. You will see the results in the Output Viewer

Window.
~ Correlations
Table 30.11 Correlations between Two Variables
Sex
distribution
of persons {Inncome in Rs.
Sex distribution Person Correlation 1 —.136
of persons Sig. (2-tailed) . .472
N 30 30
Inncome in Rs. Person Correlation —.136 1
‘ Sig. (2-tailed) 472 .
N 30 30

Linear regression: The linear regression technique is used to: (a) test
the hypotheses concerning the linear relationship between two variables
(b) estimating the specific nature of relationship; and (c) to predict the
values of dependent variable when you know the values of independent
variable. To run the linear regression procedure follow the steps given
below. ~

t)  Select Analyse->Regression->Linear..command from the menu | « ;.
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Research Findings 2) Click on the variable name that will be dependent variable in
the left side box. Shift the dependent variable to the box under
Dependent area using arrow tab.

B inear }wprf ssian

Figure 30.26 Linear Regression

3) Click on the variable name that will be independent in
the left side box. Shift the independent variable to the box
under InDependent(s) area using arrow tab.

4) Click OK button. You will see the results in the Output Viewer
. Window.

Observe that the output consists of four points: (a) a table of variables
used in regression, (b) a model summary, (c) an ANOVA table; and (d) a
table of coefficients. You may be interested in a portion of the output.
We will explain how to select a partial output in another Unit on use of
SPSS in report writing.

Regression
Table 30.12 Variables Entered/Removed
Variables Variables
Model Entered Removed Method
1 Sex
_distribution . Enter
of persons

a) All requested variables entered
b) Dependent Variable : Income in Rs.
Table 30.13 Model Summary

Adjusted Std. Error of
Model R R Square R Square the Estimate

1 1362 .019 —.016 194413.110
116 a) Predictors: (Constant), Sex distribution of persons




Table 30.14 ANOVA®

Sum of Mean
Model Squares df Square F Sig.
1 Regression | 2.01E+10 1 | 2.005E+10 | .531 4722
Residual 1.06E+12 | 28 | 3.780E+10
Total 1.08E+12 | 29

a) Predictors: (Constant), Sex distribution of persons
b) Dependent Variable: Income in Rs.

Table 30.15 Coefficients?

Unstandardzed [Standardized
Coefficients . | Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) 314275.0| 114722.6 —.136 2.739(.011
Sex distribution
of persons —51825.0|71147.913 —.728}.472

a) Dependent Variable: Income in Rs.

30.6 Multivariate® Analysis

Sometimes, you may be interested in exploring complex relationships
involving more than two variables. In this section, you will learn how to
cross tabulate your data for the analysis of relationships between more
than two variables. Similarly, how to compute multiple regression analysis
has also been covered.

Elaboration of cross-tables

In the earlier section, you have learned the cross-tabulation of two
variables. You can introduce a third variable by sub grouping one of the
- two variables. This can be done by introducing a variable as control
variable. A control variable decomposes the data into sub-groups based
on the categories of the control variable. To add a control variable for
your cross-tabulation, follow the steps given below. :

1)  Select Analyse->Descriptive Statistics->Crosstabs...command from
the menu bar. The Crosstabs dialog box appears on the screen as
shown on the next page. '

2)  Click on the variable in the source list that will form the row(s) of
the table. Shift this variable to the box under Row(s) using arrow
key.

3) Similarly, shift the variable that will form the columns of the table
from source list to the box under Column(s) using arrow key.

4)  Click on the variable which will act as control variable | (this variable
splits the variable selected at step-3 into sub groups). Shift
the control variable. to the box under Layer 1 of 1 using
arrow key.

5) For computing the row/column/total percentages in the table,

Using SPSS for Data
Analysis Contents

B117



Quatitative Methods
and Presentation of
Research Findings

118+

I~ Display chutiesed bar chasts
I Suppeess lables |

‘ Figure 30.27 :
Crosstabs: Cell Display for Computing the Row/Column/Percentages

click on Cells...tab. The Cross tabs: Cell Display dialog box appears
on the screen. Click the appropriate (Row, Column, and/or Total)
button under Percentages area. Click Continue button to close
the Cross tabs: Cell Display dialog box.

6) Click OK button to close the Crosstabs dialog box.

Crosstabs

Table 30.16 Case Processing Summary

Cases
Valid Missing Total
N |Percent|{ N [Percent| N |[Percent

Income group * Sex
distribution of persons| 3C | 100.0% | O .0% 30 | 100.0%
* Marital status

Let’s look at the table 30.17: income Group and Sex Distribution of
Persons’ Marital Status Crosstabulation. You will find crosstabulation of

_ marital status by income group of married, unmarried and widowed

persens with their sex distribution. This is a good example that you can
try and use in your own research work. Not only this but you can also use
the other examples given in this unit for your research project.



Table 30.17 Income Group and Sex Distribution of Persons’
Marital Status Crosstabulation

Sex distribution
‘ of persons

Marital status | Male [Female] Total
Married Income Less than Rs. 50000 Count 1 2 3
group %ofTotal | 7.7% | 15.4% | 23.1%
Rs. 100001-200000 Count 0 3 3
% of Total 0% [ 23.1% | 23.1%
Rs. 200001-400000 Count 3 1 4
- %of Total | 23.1% | 7.7% | 30.8%
More than Rs. 400000 Count 2 1 3
. %of Total | 15.4% [ 7.7% | 23.1%
Totai Count 6 7 13
% of Total | 46.2% | 53.8% 1100.0%
Unmarried Income Less than Rs. 50000° Count 0 1 1
group . % of Total 0% 1 10.0% 1| 10.0%
Rs. 50001100000 Count 1 1 2
% of Total | 10.0% | 10.0% | 20.0%
Rs. 100001-200000 Count 3 1 4
% of Total | 30.0% | 10.0% [ 40.0%
Rs. 200001-400000 Count 1 1 2
% of Total | 10.0% | 10.0% | 20.0%
More than Rs. 400000 Count 1 0 1
% of Total | 10.0% 0% | 10.0%
Total - Count 6 4 10
: % of Total | 60.0% | 40.0% |100.0%
Widowed Income Less than Rs. 50000 Count 0 2 2
“group % of Total 0% | 28.6% | 28.6%
: Rs. 100001-200000 Count - 1 0 1
: % of Total | 14.3% .0% 14.3%
Rs. 200001-400000 Count LI 2 3
% of Total | 14.3% | 28.6% | 42.9%
More than' Rs. 400000 Count 0 1 1
% of Total 0% | 14.3% 14.3%
Total : Count 2 5 7
% of Total | 28.6% | 71.4% |100.3%.

Multiple regression

“In two variable linear regression you have used one dependent variable
~ and one independent variable. The multivariate regression is used to
investigate the relationship between two or more independent variables
on a single dependent variable. The procedure for computing the statistics
for multiple regression is the same as that for two variable linear regression
explained earlier, except that you have more than one variable under
‘Independent(s) area in the Linear Regression dialog box.

1)  Analyse-> Regression-Linear..command from the menu
bar. The Linear Regression dialog box appears on the screen.

2) Click on the variable name that will be a dependent variable in
the left side box. Shift this variable to the box under Dependent
- area using arrow tab.

3) Click on the variable name that will be independent in the left
side box. Shift this variable to the box under Independent(s)

Using SPS5 for -Data
Analysis: Contents
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Figure 30.;28 Linear Regression Dialog'de

area. Follow this step until all the desired lndependent varlables
are selected. :

4) Click OK button. You will see the results in the. Output Vlewer
Window.

Regression

Table 30.18 Variables Entered/Removed

Variables Variables :
Model Entered Removed Method

1 Marital status, ;
Sex distribution “Enter
of persons,
Age in yeas

a) AUl requested variables entered
b) Dependent Variable: Income in Rs.

Table 30.19 Model Summary

Adjusted Std. Error of
Model R R Square R Sqaure |  the Estimate
1 .1682 - .028 —.084 200774.054

a) Predictors: (Constant), Marital status, Sex distribution
of persons, Age in years
+120%



Table 30.20 ANOVAP
Sum of -..Mean
Model Squares df Square. F Sig.
1 Regression | 3.03E+10 | 3 | 1.010E+10 | .250 | .860%
Residual 1.05E+12 | 26 | 4.031E+10
Total 1.08E+12 | 29

a) Predictors: (Constant), Marital status, Sex distribution of
persons, Age in years
b) Dependent Variable: Income in Rs.

Table 30.21 Coefficients?®

Unstandardzed Standardzed

Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Conspan;) 362849.3| 153394.2 2.365(.026
sex distribution' 1008 8|75727.227| —.116 |—.581].566

of persons :

Age in years —680.236 | 2431.316 —.056 —.280].782
Marital status |—18212.7 46773.389 —.076 —.389(.700

a) Dependent Variable: Income in Rs.

~ 30.7 Tests of Significance

In this section, you will learn one sample t-test* for a mean, two sample
t-test for the equality of means, and chi-square test for independence.

One sample t-test
The one sample t-test compares the sample means to a population mean,
using t-distribution as the standard of comparison.

1)  Setect Analyse->»Compare Means—>One-Sample TTest..command
from the menu bar. The One Sample T Test dialog box appears on
the screen. _ oo

2)  Click on the variable name you want to perform the t-test on the

One Sample T Test

*&mmam ?@dﬁ‘»}fm&] e
Wphgein yeus lage] B incomeniBs resme]

Teavaoe (06N . Siow. !E

Figure 30.29 One Sample T Test
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and Presentation of left side box. Shift this variable to the box under Test Variable(s)

Research Findings area. ;
' 3) Suppose you have selected Income Variable for the t-test and
"~ hypothesis takes the population mean income as Rs.200000. Type
200000 in the test box next to Test Value.

4)  Click OK button. The following is the output you will see in Output
‘Viewer Window.

T-Test ;
‘ . Table 30.22 One-Sampile Statistics
: | Std. Error
; N Mean |Std. Deviation| Mean
Income in Rs. | 30 234810.00 | 192833.232 | 35206.370

Table 30.23 One Sample “Test with Test Value
. Test Value = 200000 ~
, 95% Confidence -
. . ‘ Interval of the
, Sig. -'Mean Difference
t | df |(2-tailed) Difference| Lower Upper

Income in Rs.|.989 | 29 .331° | 34810.00 |-37195.11]|106815.11

Two sampte T- ‘

Sometimes, our data anm,, focmes on two distinct groups w1thm a
.singlte poputation or we may want to compare the two populations in
terms of their respective means. The two-samptle t-test for the equality
of means will hetp you in this,

- 1) Select Analyse->Compare Means->independent-Samples T

2122¢ | Figure 30.30 Exompte SPSS Darta Er.htor' income Vanable



2)

3)

4)

Test...command from the menu bar. The Independent-Samples T
dialog box appears on the screen.

Click on the Variable name in the left side box that you want to
include for the t-test. Suppose you want to include income Variable,

shift this variable to the right side box under Test Variable(s)

using arrow key.

Click on the variable you want to group. Suppose you want to test

the income mean difference between males and females, click on.

sex variable. Shift this variable to the box under Grouping Variable
using arrow key.

Click on the Define Groups..button. The Define Group dralog
box appears on the screen. Type ‘1’ in the Group 1 box. Type 2’

in the Group 2 box. Click Continue button to close the Define

Groups dialog box.

| [ 80w yers fagel
w2l F 1 Maniktel slotus imartel] 0 L
Bar g

f‘ uam«hn {r'--——
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Figure 30.31 Example SPSS Data Editor: Grouping Variables

5) Click button to close the Independent-Samples T Test dialog
box. The following table presents the output.
T-test
Table 30.24 Group Statistics
Sex distribution Std. Std. Error
of persons N Mean Deviation Mean
Income in Rs. Male 14 | 262450.00 | 176610.187 | 47201.058
Female 16 | 210625.00 | 208616.994 | 52154.248

Using SPSS for Data
Analysis Conteats
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Qualitative Methods Table 30.25 Independent Samples Test
and Presentation of

Research Findings Income in Rs.
Equal Equal
variances | variances
assumed |not assumed

Levene’s Test for F .118

Equality of Variances Sig. : .734

t-test for Equality of t .728 .737

Means df ’ 28 27.978
' Sig. (2-tailed) 472 .467

Mean Difference ,
51825.00 51825.00
Std. Error Difference ‘
71147.913| 70342.061
95% Confidence
Interval Lower |[—93914.893(—92269.306
of the Dfference Upper | 197564.893| 195919.306

Chi-square test® for independence

The chi-square test for testing the independence of attributes is for the
categorical data arranged in a cross tabulation. The chi-square test
appears as an option within the procedure for generating a cross-
tabulation. The steps for chi-square test are repeat of steps for
generating cross-tabulation with the addition of Expected counts under
cells and chi-square under Statistics.

1) Select Analyse->Descriptive Statistics>Crosstabs command from
the menu bar. The cross tabs dialog box appears on the screen.

2) Select a variable under Row(s) and another variable under
Column(s). Suppose you have selected Income level (a categorical
variable with income levels low and high) variable under Row(s)
and sex variable under Column(s).

f Joo e

s
- & ; Sl

Figure 30.32
Crosstables: Income
Levels

124




3)

4)

Click on the Statistics...button in the Cross tabs dialog box. The
‘Cross tabs:Statistics dialog box appears on the screen. Check mark the
Chi-square button. Click Continue button to close the Cross tabs: Statistics
_dialog box. '

I Conslsiions

" Contingency cothclerd [ Gaing
PNME#MW i Somers d P Hw
:g ;;;;;;; Labda 7 Kendalstaub
 Neminh by irierval Cf Kapes
{7 fte © 1 Risk
I Meklamar

(™ Coshwans and MartetHssrsael satistics

Flgure 30 33 Crosstabs: StatlSthS

Click on the Cells...button in the Cross tabs dialog box. The
_Crosstabs:Cell Display dialog box appears on the screen. Check
mark both Observed (if not already check marked) box and
Expected box under Counts. Click Continue button to close Cross

tabs:Cell Display dialog box.

?ec@erﬁages Residuals
, T Rew | X Urstandaidized
7 o 1 lanaadied
7 Tetal l Aemmm
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Figure 30.34 Crosstabs: Cell Display
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and Presentation of Click OK button in the Cross tabs dialog box. The output generated

Research Findings is shown below.
Crosstabs '
Table30.26 Case Processing Summary
—Cases
Valid Missing Total

N [Percent] N [Percent]| N [Percent

Income group * Sex
distribution of persons | 30 | 100.0% | O .0% 30 100.0%

Table30.27
Income level * fSex distribution of persons Crosstabulation

Sex distribution
of persons

Male Female Total
income Low Count 4 8 12
level Expected Count 5.6 6.4 12.0
High Count - 10 8 | 18
Expected Count 8.4 9.6 18.0
Total Count 14 16 30
Expected Count 14.0 16.0 30.0

Table30.28 Chi-Square Tests

Asymp. Sig. | Exact Sig. | Exact Sig
Value | df | (2-tailed) | (2-tailed)| (1-sided)
Pearson Chi-Square 1.429° | 1 .232
Continuity Correction®| .675]| 1 411
Likelihood Ratio 1.448| 1 | .229
Fisher’s Exact Test ] .284 | .206
Linear-by-Linear 1.3811 1 .240
Association ‘
N of Valid Cases 30

a) Computed only for a 2X2 table
b) 0 cells (.0%) have expected countless than 5. The minimum
expected count is 5.60.

Reflection and Action 30.3
- Answer the follqwing question on the basis of what you have just finished reading.

| % What are the different views available in SPSS Data Editor? . |
< Explain when would you use each of these views?

- 30.8 Conclusion

In this unit "you have learned the use of the SPSS Program to enter
the data in a data file and use this data file for the analysis of data.
You might have generated a data file using some other data
+1264 base programs such as Excel. It is very easy to convert such data files



into a SPSS data file. ; Using SPSS for Data
Analysis Contents

This unit provides an introduction to the SPSS. You can do a range of -~
statistical analyses from simple cross tabulation to more complex
statistical techniques, depending upon the individual researcher’s
requirement. However, we have tried to explain only simple commands
and statistical tools, which are more popular in social research. We will
leave it to the student to try and learn the full range of features in SPSS.

Further Readmg@

Nie, N. H., C.H. Hull, J. G. Jenkins, K. Steinbrenner and D. H. Bent
1979. Statistical Package for the Social Sciences. McGraw Hill: New
York

— % ——— ‘ 21274
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Unit 31
Using SPSS in Report Writing

Contents

31.1 Introduction
31.2 Why to Use SPSS

31.3 Charts

31.4 Working with SPSS Output

31.5 Copying SPSS output to MS Word Document
31.6 Conclusion

Learning Objectives £ >
It is expected that after going through Unit 31, you will be able to

% Edit the SPSS output Tables to suit your needs in report writing
¢ Create and edit Charts for graphic presentation of your data analysis

®

*%*  Copy the SPSS edited Tables and Charts directly in your report.

31.1 Introduction

Unit 29 you read about SPSS and now in Unit 31 you will learn how to
modify or edit the Tables generated by the SPSS to meet your specific
needs in writing reports. Creating and editing Charts are covered to
enhance your report presentation skills. Also, you will learn how to copy
the edited tables and charts in a MS Word document where your main
report file may be accessible.

31.2 Why to Use SPSS

In SPSS, when you run a statistical procedure, the results are displayed in
a window called Viewer. At the time of including these results in your
report, you may wish to create a professional-looking report both quickly
and easily. Powerful calculation and formatting capabilities of SPSS let
you design your own highly specialised reports, such as cross-tabulation.
You can use formatting tools to change fonts, colours, styles, column
size, row size, and alignment. The use of preset formatting in style
sheets can eliminate the need to reformat each new report.

Often, the most striking way of presentation of data is with Charts
(also, often called Graphs). A Chart provides a quick visual sense of the
main features of the data. Using SPSS, you can create and edit Charts
for your data. ‘

Normally, you use MS Word or some other word processing program to
type your report. You include the Tables and Charts generated by the
SPSS in the report to support your analysis. Using the Copy and Paste



functions of MS Word, the Tables and Charts generated by the SPSS can
be copied from the SPSS Output Window and pasted into the Word Window
without having to create new Tables and Charts.

31.3 Charts

A chart is a graphical presentation of data Before you create a chart,
you should keep in mind:

% The title identifies the chart. Therefore, give the chart an
appropriate title.

Category (X) axis identifies the data being charted on the horizontal
X-axis. Examples of Category X-axis include dates, persons, places,
groups, etc. Therefore, clearly identify the categories of the
variable and give an appropriate category axis title.

/)

o

%  Value (Y) axis identifies the data being charted on the vertical Y-
axis. Examples of Y-axis labels include numbers, value of currency,
percentage, etc. Therefore, clearly identify the value along with
an appropriate value title.

important for identifying which information relates to what class.

A number of types of charts (pie charts, bar charts, histograms, etc.)
are available to portray certain types of information. You must,
~ therefore, choose the correct type of chart for information you wish to
project.

Many of the charts available in SPSS come in two different general formats:
(a) Standard chart; and (b) Interactive charts. The standard charts are
created either from the main Graphs menu bar or by statistical procedures.
The interactive charts are created from the Interactive sub-menu of the
Graphs menu bar and the charts created from pivot tables. However, we
will limit this Unit to creating and editing Standard charts only.

Pie Charts can be created using any of the level of measurement of data
(nominal, ordinal, interval, or ratio). Bar charts can be created using
nominal, ordinal, or interval/ratio (discrete variables) data. Histograms
are created using interval/ratio (continuous variables) data. The polygon
chart can be created using interval/ratio data.

Creating standard charts
In this unit, we shall be concerned with the creation of a simple Pie chart
.and then a Bar chart.

_Pie Chart: A pie chart can be constructéd for all levels of measurement.
To create a pie chart, follow the instructions given below:

1)  Select Graphs->Pie... command from the menu bar in the Data
Editor Window. The Pie Charts dialog box (figure 31.1) appears on the

% Legends@ identify the information charted. A legend will be '

Using SPSS in
Report Writing
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screen asking you to define the cases in a variable or separate
variables.

a)

b)

c)

Figure 31.1 The Pie Charts Dialog Box

If you want the summary (number, percentage, etc.) of cases in
each category groups available in the same variable check mark:
the Summaries for groups of cases button. For example, you
may wish a pie chart to show the gender distribution of the number
of respondents (sex variable: Number of male and female
respondents).

If you want the summaries (total, percentage, average, count,
etc) of different variables as a pie chart check mark the Summaries
of separate variables button.

If you want simply the values of individual cases as a pie chart,
check mark Values of individual Cases button. For example, you
might have typed the number ‘25’ as male respondents as case-1
and the number ‘30’ as female respondents against case-2 in
‘gender’ variable.

In our example, we have check marked Summaries for groups of cases
button, since the gender sub groups (male and female) are in sex variable.

2) After check mark .

W Define Pie: Summaties fur Gronps of Cases

. . . “m A - ) )
l.ntheapl?ro,prlatebt{tton ’f“ﬁ:: Poysnny ﬁ“_ ’
in the Pie charts dialog | |g e o) ( Om nokouss £ G Xefoam | _Pato
' : -} @ ncone poup Incgron [ Gien svessiany Suncion. g - R
box, press the Define |1Qremmmarnt | P—— | ’.’.j_:‘;_i
button to close that | t E.“ b Y
dialog box. The Define T ' ’ —
Pie: Summary for r.____.!...__. ‘
Groups of Cases dialog - b - ‘ ,
box appears on the ﬁfu-mm ;J‘_!:.i
screen. The default ; [ i .;"!‘;.'h.?

setting for what each
slice of a Pie chart should
represent is the number

Figure 31.2 Define Pie:
Summaries for group of cases

" of cases. Check mark N of cases button if it is not already check

marked. You can also check mark % of cases button if required in place
of number of cases. Transfer the variable(s) on which you want the pie



chart from left variable box to the box under Define series by: using Using SPSS in
arrow key. : Report Writing

Remember that when charts are created, they do not show the missing
cases category as default as you have seen in Unit 30 on Using SPSS for
Data Analysis. If you want to display this category make sure that the
number of cases with missing values is not excessive. To display missing
values, click the Options button to define the missing values. The Options -
dialog box appears. Checks mark the Display groups defined by missing
values button and then click Continue button. Click OK button in the.
Define Pie... dialog box to create a Pie chart.

[ Reflection and Action 31.1

Read carefully the text given above about creating standard charts and answer
the following questions. Write your answers in the context of creating a pie
chart on the gender distribution in India.

** When you create a chart in SPSS, what are the important points you should
keep in mind?
e  Discuss the steps involved in creating a Pie Chart on the topic mentioned

_____,___._.__._.—._..._.___—_——__.-_——_—_—.__—-_

Graph: See figure 31.3 an example of a completed Pie Chart on the
gender distribution in India.

Female

Figure 31.3 Example of a combleted Pie Chart on the gender
: distribution in India’

‘Bar Charts: To generate a bar chart, select Graphs->Bar.. command
Bar Charts g from the menu bar of the Data
: Editor window. The Bar Charts dialog

box appears on the screen. You have
‘three options available in this dialog
| box: (a) Simple bar charts, (b)
4| Clustered bar charts, and (c)
- Stacked bar charts. Select your
option by clicking on the respective
chart box, define the case as you
have done for pie chart by clicking

‘_‘ N either Summary for groups of
Mﬁlmdm cases, or Summary of separate

X Mdmm | variables, or Values of individual
Lo m#ww ~+w.i| cases box under Data in Chart Are
i e eesine | grea in the Bar Charts dialog box.
Figure 31.4 Bar Charts In our example, we have check #1314
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marked Summaries for groups of cases button, since the gender sub
groups (male and female) are in sex variable.

Click on the Define button in the Bar Charts dialog box to close it. The
Define Simple Bar: Summary for Groups of Cases dialog box appears
on the screen, which is identical to the Define Pie dialog box. Transfer
the variable(s) on which you want the bar chart from left variable box to
the box under Category Axis: using arrow key. The default setting for
what each rectangle of .a bar chart should represent is the number of
cases. Check mark N of cases button if it is not already check marked.
You can also check mark % of cases button if required in place of number
of cases. Click OK button to generate the bar chart in the Output
Viewer window.

W Define Simple Bar: Swmmaries for Groups of Cases

g st s i RS APREEOE : - .
| g v (508 , B o
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Figure 31.5
Define Simple Bar: Summaries for Groups of Cases

Graph: See in figure 31.6 an example of a completed Bar Chart.

16.5
16.0
15.54
15.04
14.5-
14.0

:%13.5 ' %

Male ) Female

n

Count

] , Figure 31.6
Example of a completed Bar Chart on Sex Distribution of Persons
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Editing Chart Output : Using SPSS in
. Report Writing
- The basic SPSS procedure on creating graphs produces a bare minimum

amount of information about the chart. You do not get a titte, or number,
or percentage for each slice of the chart. You could have generated title
of the graph by clicking Titles button on the Define Pie...dialog box in
case of pie chart or Define simple bar... dialog box in case of bar chart.
However, in SPSS a number of options are available to improve the
graph. You can do this with the help of SPSS chart Editor.

1) Double click anywhere on the chart. The Chart Editor dialog box
appears along with a menu bar. You can choose a number of
options to improve the chart or change one type of chart to
another type of chart.

Male
Female

Figure 31.7 Chart 1: SPSS Chart Editor

2) Changing to a different type of chart: To change the type of
chart from pie chart to bar chart, select Gallery->»Bar command
from the menu bar in Chart Editor. The Bar Charts dialog box
appears. You have three options (Simple, Clustered, or Stacked).
Click the Replace button to change the chart type to a (Simple)
bar chart.

3) Adding Titles to your
chart: To add titles to the

Tite 1 ,DTMM@WMM.#W m chart, select Chart->Title
. : command from the menu

Te2 | . Caros
- Thie instiicabor:  [Comer =] ___j | bar in Chart Editor. The
Sublitle: | - ‘ wp |} Titles dialog box appears.
s sation. [Coter < Type the title of the chart

\
\
\
|
|
|
— | in the Title 1: and/or Title
Figure 31.8 Titles 2: box. Click OK button to #133%
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close this dialog box and insert the title.

4) Adding
Footnote: To add
footnote to the
chart, select
Chart=> Footnote
command from
the menu bar in , , 3 - S
the Chart Editor. Figure 31.9 Footnotes
The Footnotes . .

dialog box appears. Type the text for footnotes in the Footnote 1: and/
or Footnote 2: box. You can also align (Centre, Left, or Right) by
selecting the option the Footnote Justification-box. Click OK button to
close this dialog box and insert the typed footnotes.

5) Options:
select Chart>
Options command
from the menu bar
in the Chart Editor
to change the
information that is
attached to each
slice of the Pie. As |L s
we have seen earlier - Figure 31.10 Pie Options
at the time of : _
creating a chart the default setting for text labels (male/female, etc.)
is represented by each slice. In the options dialog box click on the Values
and Percents boxes to generate absolute (number) and relative (percent)
frequencies for each slice disptayed along with the text label. By clicking
Format button, you can atso set the decimal places either to zero or
some other required number of digits.

The Gender Distribution of Respondents
/ffﬂ I

Pie Options

-t

Male
46.7%

~

o

Figure 31.11 Pie Chart on The Gender Distribution of Respondents

You can edit the bar chart created earlier using various features in the
Chart Editor.

An example of refined bar chart is shown on the next page.
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Count

20 ' Report Writing
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13 ~ : // Count
2| T/
10
8
6
4 / .
. B
0 ./ V744 Figure 31.12
Male Female Bar Chart on the Gender
Sex distribution of persons Distribution of Respondents
T S . s - - - - A
| Reflection and Action 31.2 |
| At the time of editing a chart you can add er modify some information about the |
| chart. What are the options available for doing so? Discuss the options in terms of |
| changing the chart shown as figure 32.4 in Unit 32 to a different type of chart, |
[ 2dding HIGERMERIOGENE. WEN | BN BN W W a

31.4 Working With SPSS Output

All the output generated from statistical and graphical procedures will
appear in the SPSS Viewer Window. Every time you run a new procedure
in the same session, the output is added at the end of the output of the
previous procedure. If the output Viewer Window is closed and another
procedure is run, a new output Viewer Window is automatically generated.
The Viewer Window has two components: (a) the Outline Pane*, and
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Figure 31 13 Output 1: SPSS Viewer 35+



Qualitative Methods (b) Contents Pane. The Ouftline Pane is located at the left hand side of
and Presentation of . . . . . .
Research Findings the Output Viewer Wlndow and shows the output in outline view as a list
of items. The Contents Pane is located at the right side of the Output
Viewer Window and displays the actual contents. (tables, charts, and

text) of the output.

You can click and drag the riéﬁt (left) border of the outline pane (contents
pane) to change the width of the Qutline Pane (Contents Pane). This will
facilitate enough room in the respective viewer pane.

Browsing Results: You can use the scroll bars (both vertical and horizontal)
to browse the results. If you want to go to a particular table/chart/text,
click the corresponding caption of the item in the Outline Pane.

You can use the Output Viewer Window to:
<> Browse through the results

I Show or hide selected tables/text/charts

)
0.0

Change the display order of results by moving selected items

J/
o

Use the Draft Viewer for simple text output

K/
0.0

Use the Pivot Table Editor to rearrange the rows, columns, and layérs

/7
0.0

Copy the items in other applications such as MS Word

J
[ (4

Delete the selected tables/text/charts

o
o

Add items to viewer

e -

)
0‘0

Printing the ‘output

You have learned how to print the output in the earlier Unit on SPSS.
You will learn how to copy items in MS Word in the next section of this
Unit. '

Hiding and Showing Output: In the viewer, you can selectively hide or
show the individual text/table/chart. The hidden items (text/table/

SUCWRMCECIEN 1 Output!  SPSS Viewer
be viewed, '
File ENft VWew Ifooert Flomobt Annblyee GEoabhs

copied, or printed NS
y _

with the rest of .

the output. To
hide a table/text/
chart, double click
its open book icon
in the Outline Pane
of the Viewer.
The open book
icon changes to a
closed book icon a
signifying that the ) Figure 31.14

Output 1: SPSS Viewer Hiding the Items
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particular item of a procedure is hidden. To hide all the results from a
particular procedure, click the box to the left of the procedure name in
‘the Outline Pane. This hides all the items (results) from the procedure
and collapses the Outline View.

To redisplay the hidden item(s), double click the closed book icon.

Changing Display Order of Items: You can also change the order in
which the output is displayed. In the outline pane, click on the items you
want to move. Drag the selected items (hold down the mouse button
while dragging) to a new location in the outline and release the mouse
button. You can also move items by clicking and dragging in the contents
pane or selecting Edit->Cut command and then select Edit->Paste After
command on the menu bar.

Deleting Items: Click an item on the Outline Pane or Contents Pane to
selxct the item. Press Delete key on the keyboard. The item is deleted.

Changing Items Alignment: By default all results are initially left aligned.
You can change the alignment of selected items. For this, click on the
items either in Outline Pane or Contents Pane to select the items you
want to align. Select Format->Align Left to align left or Format->Align
Right to align right or Format—>Align Centre command from the menu
bar.

| &% Output1 - SPSS Viewer
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Figure 31.15 Output 1: SPSS Viewer Changing Items Alighments

Adding Items: In the Output Viewer, you can add items such as text,

charts, or material from other applications such as Word or Excel. Text

items not connected to a table or chart can be added to the Viewer.
Click on the text, table, or chart object will precede the title or text you
are intended to add. Select Insert->New Title command or Insert->New
Text command from the menu bar. Double click the new object. Enter
the text/title you want at this location.
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Figure 31.16 Out;)uf 1: SPSS Viewer 'Adding Items )
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To insert a text file, in the Output Viewer, click a table, chart or text
item that will precede the text file you are indented. Select Insert->Text
File... command from the menu bar. Select the text file to be inserted.
Observe that the text file is inserted. To edit the text, double click the
item.

Draft Viewer

The Draft Viewer provides results in a draft form when you run a
procedure. The text output in the Draft Viewer can be edited, the
charts can be resized, and both the text and charts can be copied to
other applications such as MS Word. You cannot edit the charts and the
Draft Viewer does not include interactive features of pivot tables. That
means if you prefer simple text output rather than interactive pivot*
tables, you can use the Draft Viewer.

To create a draft output, open the Draft Output Window by selecting
File=>New->Draft Output command in the Data Editor Window and
then run a procedure in the Draft Viewer Window.
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Figure 31.17 Draft 5: SPSS Draft Viewer

Controlling the Format: The output that would be displayed as pivot
tables in the Draft Viewer is converted to text output. The default
settings for converted pivot table output include:

a) Each columh in the table is set to the width of that column label.
Therefore, the column labels are not wrapped in multiple lines.

b) Instead of tabs, the alignment is controlled by spaces.

c) .Box characters from the SPSS market set are used as row and
column separators. If the box characters are turned off, vertical



. line characters (|) are used as column separators and dashes (-)
are used as row separators.

You can control the format .of the table output using Options dialog box
before you run a procedure. For this, select Edit->»Options command in
the menu bar before you run a procedure. The Options dialog box
appears on the screen. Click on the Draft Viewer button. To reduce the

width of tables, you should reduce the column width containing long

labels. Click on Maximum button under Column width: area in the
options dialog box. Type the maximum number of characters that a
column Width can hold in the box against characters. The labels longer
than the specified width are wrapped to fit the maximum column width.
You can change the default box characters for row and column borders.
You can also specify different cell separators or enter blank spaces if you
do not want any characters used to mark rows and columns. For this,
remove the check mark in the Display Box Character box in the options
dialog box. Type a character (which you want as row separator) in the
box against Row: Under Cell Separators: area. Similarly, type a character
(which you want as column separator) in the box against Column: Under
Cell Separators: area. Typing a space character in the Row: and/or
column; boxes will result a table with corresponding blank borders.
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Flgure 31.18 Options

The Draft Viewer is designed to display space-separated output in a
fixed pitch fpnt. If you want to copy the*output to some other application
such as MS Word document, select Tabs for the column separator. For
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this, check mark the Tabs button against Separate Columns Width in the
options dialog box. With this selection, you can use any font that you
want in the MS Word like applications and set the tabs to align output
properly. However, tab separated output will not align properly in the
Draft Vlewer You can change the font type and their sizes in the Options
dialog ‘box. For this select the font type in the list box Under Font and
then the size in the next list box. To print or save the Draft output
follow the steps explained in earlier Unit on SPSS.
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Pivot Tables

In SPSS many of the results from statistical procedures are dlsplayed in
default Pivot tables. The default labels produced may not display
information as neatly or as clearly as one would like. With Pivot tables
you can rearrange the rows, columns, and layers. Some of the options
for modifying a Pivot table are:

X Interchangmg rows and columns

< Moving rows and_ columns

< . Creating multidimensional layers

<> Grouping and ungrouping rows and columns

<> Showing and hiding cells
1 Roiating row and column labels
o Finding definitions of terms used

Accessing Output Definitions: Mgny of the statistical terms are displayed
in the output. Definitions of theése termscan be accessed directly in the
Output Viewer. For example, double click Case Processing Summary
pivot table. Right click Valid and select What'’s This? from the pop-up
menu. Observe that the deflmtlon of- Valid is dlsplayed in a pop-up .
Window. B
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Figure 31.20 Case Processing Summéry

Editing a Pivot Table

To edit a Pivot table, activate the table by double-clicking the table you
want to edit. Click a label or text or number you want to edit. The
menus change to display commands relevant for editing table attributes.
In addition, a table toolbar and a Pivoting Tray dialog box appear allowing
you to change the table attributes.

Figure 31.21 Output 2: SPSS Viewer

If the Pivoting Tray dialog box is not visible on the screen, select
Pivot?Pivoting Trays command from the menu bar. The Pivoting Trays
provide a way to move data between columns, rows, and layers. The .
Pivoting Tray contains three pivot icons representing layers, columns,
and rows. Move the cursor on one of the pivot icons to see what it
represents. The shaded area in the table indicates what will be moved
‘when you move that pivot icon. Also, when you move the cursor on a
pivot icon,.a pop-up label will be displayed indicating what that icon
represents in the table. Drag an icon from one tray.to another tray. The
“table immediately changes the arrangements in the table. For example,
if you want to change the sex category from the row to cotumn drag the

icon from Row tray to the Column tray. : 16— +141%
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Transposing Rows and Columns: Activate the table by double clicking
the table.. Select Pivot-¥Transpose Rows and Columns command on

the menu bar. This will change all the columns to rows and rows to
columns.

Sex distribution of persons * Marital status Crosstabulation
Count

Marital status
Count Married |Unmarried|Widowed| Total
Sex distribution Male 6 6 2 14
of persons Female| . 7 4 5 16
Total 13 10 7 30
Sex distribution of persons * Marital status Crosstabulation
Count
Sex distribution
of persons
Male | Female Total
Marital Married 6 7 13
status Unmarried 6 4 10
Widowed 2 5 7
Total 14 16 30

Figure 31.22 Transposing Rows and Columns

Changing the display order of rows and columns: The order of Pivot
icons in dimension (row, column, layer) tray reflects the display order of
elements in the pivot table. Drag the respective icons in each tray to
the order you want (left to right or top to bottom).

Moving rows and columns: Activate the Pivot table by double clicking.
Click the label for the row or column you want to move. Click and drag
the label to the new position. Select Insert Before or Swap from the
pop-up menu.
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Figure 31.23 Moving Rows and Columins



Grouping Rows and Columns: You can group a number of rows or columns
in-a table by inserting a group label. For this, activate the table by
double clicking on it. Select the rows or columns you want to group
together. Click and drag the mouse to select multiple cells containing
row headings or column headings where you want to insert a row or
column group heading. Select Edit?Group command on the menu bar. A
group label is automatically inserted. Double click the group label to edit
the label text. If you want to add a new row or column to an existing
‘group, You should first ungroup the items currently in the group and
then create a news group that includes the new items. To ungroup rows
or columns you should remove the group labels. For this, select the
group label by clicking anywhere in the group label for the rows or
columns you want to ungroup. Select Edit=>Ungroup command on the
menu bar. This will automatically delete the group label.

Rotating Labels: You can rotate either the inner most column labels or
outer most row labels. For this activate the Pivot table. Select

Format—)RQtateélnner Column Labels command for rotating innermost
column labels or Format->Rotate Outer Row Labels for rotating outer -

most row labels.

Sex distribution of persons * Marital status Crosstabulation
Count

Marital status
Count Married |Unmarried{Widowed| Total
Sex distribution Male 6 6 2 14
of persons Female 7 4 5 16
Total 13 10 7 30
Sex distribution of persons * Marital status Crosstabulation
' Count '
Marital
status
=]
2 2
2152
5| E|2| 8
= ||| F
Sex distribution Male 6| 62|14
of persons Fematle| 7| 4|5 |16
Total 13110 7 {30

Figure 31.24 Rotating Labels

‘Creating and Displaying Layers: Layers can be useful for large tables
with nested categories of information. By creating layers, you can
simplify the look of the table, making it easier to read. Layers work
best when the table has at least three variables. Activate the table by

Using SPSS in
Report Writing

1439



Qualitative Methods
and Presentation of
Research Findings

double clicking it. Drag an icon from the Row tray or column tray into
the Layer tray. Each layer icon has left and right arrows. The visible
table is the table for the top layer. To view the different layers, you can
either click the arrows on layer icon or select a layer from the drop-

~ down list in the table.

Hiding cells: You can hide many types of cells in a table:

a) Dimension labels

b)  Category labels without hiding the data cells .
c) Label cell and data cells in a row or column
d) Footnotes, titles, and captions

To hide rows and columns in a table, select View-Hide on the Pivot Table
menu bar or right click the highlighted row or column to show the pop-
up menu and then choose Hide category from the pop-up menu.

To show the hidden rows and columns in a table, select another label in
the same dimension as the hidden row or column. For example, if the
Male category of the Gender distribution is hidden, click the Female
category. Select View->Show All Categories in Gender command on
the menu bar or select View->Show All command on the menu bar.
This command displays all hidden cells in the table.

To hide (or show) a dimension label, activate the pivot table. Select the
dimension label or any category label within the dimension. Select
View->Hide (or Show) Dimension Label command on the menu bar to
hide (show) the selected dimension label.

To hide or show a footnote in a table, select the footnote and then
select View?Hide (or Show) command on the menu bar to hide (or show)
the selected footnote.

TableLooks: You can change the appearance of a table either by changing

B et pyial
i et

Todseds.. Sumin

Figure 31.25 TablelLooks



table properties or by applying TableLook. Each TableLook consists of a Using SPSS in

collection of table properties, including general appearance, footnote Report Writing

properties, cell properties, and borders. You can either select a preset

TateLook or create and save a custom TableLook of your own. To apply .

a preset TableLook to your table, activate the pivot table by double |

clicking the table. Select Format->TableLooks... command on the menu
- bar. The TableLooks dialog box appears on the screen. Select a TableLook
. from the list of files under TableLook Files. Click OK button to apply the
. selected pivot table.

To edit a selected TableLook or to create your own TableLook, select a
TableLook from the list of files as explained above. Click Edit Look
button. The Table Properties dialog box appears on the screen. Select
the appropriate options in the menu to adjust the table properties for
attributes you want. Click OK button in the Table properties dialog box.
Click Save Look to save the edited Table Look or click Save As to save it
as a new TableLook. Note that editing a TableLook affects only the
selected pivot table. An edited TableLook is not applied to any other
labels that use that TableLook unless you select those tables and reapply
the Tablelook.

The Table properties dialog box allows you to set general properties of a.
- table, set cell styles for various parts of a table, and save a set those
properties as a TableLook. ‘
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Using General tab on the Tabte Properties dialog box, you can control
general properties of the table such as ‘hiding empty rows or columns
and adjusting printing properties.

Click the Footnotes tab to control the format and the position of footnote [c

+145%
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Click Cell Formats tab to determine specific formats for cells in the data
area, for row and column labels, and for other areas in the table.

Click Borders tab to control the width and column of the lines forming
the borders of each area of the table.

Click Printing tab to control printing properties.

Reflection and Action 31.3

You have just learnt the while working with SPSS output, it is possible carry out
several activities like browsing through the results, show or hide selected table/
text/ charts etc.Write answers of the following questions.

How do you transpose the rows and columns of a table? What are the steps
involved in it?

Can it be possible to hide some results in SPSS Output Viewer without being
deleted? If so what are the steps to hide the selected results?

What dialog box will help you in changing the look of a Pivot Table. What are the
general properties you can control using this dialog box?

-
I
I
|
I
I
I
|
I
I
I

31.5 Copying SPSS Output to MS Word Document

If you want to include some or all of your tables and charts generated by
SPSS into your report, you can copy and paste them from the "SPSS
Viewer window into a Word document. The basic procedure is same for
copying data from the Data Editor and text, tables, and charts from
Output Viewer window. ‘

1)  Copy the text, table, or chart from the SPSS Output Viewer
window to the Windows Clipboard. Or copy the data from the
SPSS Data Editor to the Windows Clipboard.

2)  Paste the copied data/text/table/chart to the Word document
from the Windows Clipboard.

This means, while copying and pasting the data/output, the respective,
program should be open.

Copying Data from SPSS Data Window

Figure 31.27 Example: SPSS Data Editor
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To copy the data from your SPSS Data Editor into your Wofd document,
follow the steps given below:

1) Start the SPSS program. Open the data file (with extension .sav)
using the Data Editor. Select the data area (rows and columns)
you want to copy.

2) Select Edit>Copy command from the menu bar of SPSS Data
Editor Window. The data is now copied to the Windows Clipboard.

3) Start the Word program. Open the Word document where you
‘ are typing your report and want to copy the selected data. Select
the page and paragraph. Position the insertion point by clicking

the mouse.

4) Select Edit->Paste command from the menu bar of Word window.
The data is now copied from the Windows Clipboard to your Word
document at the insertion point.

Or

Select Edit>Paste Special command from the menu bar of Word window.

The Paste Special dialog box appears on the screen. Select Unformatted

Text under As: and then, click OK button. The data is now copied from

the Windows Clipboard to your Word document at the insertion point.

Paste \pecial

 pmy  Isestsithecortents of the Cipdosd a3 tet without

Figure 31.28 Paste Special
You can edit the data or reformat the settings if needed in your Word
document. '

2 24 1 150000 3.00 1.00
1 52 1 345000 4.00 2.00
2 65 3 - 45000 1.00 1.00
1 35 3 245000 4.00 2.00
1 42 1 23000 1.00 1.00
1 25 1 670000 5.00 2.00
2 23 2 345000 4.00 2.00
2 63 1 156000 3.00 2.00
1 41 2 65300 2.00 1.00
2 48 1 150000 3.00 1.00

Figure 31.29 Data as Copied from SPSS Data Editor
into Word Document *147<
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Copying Text or Tables from SPSS Output Viewer

We will explain here the following three formats: (a) Picture, (b) Formatted

Text (RTF), and (c) Unformatted Text. For clarity, we will also explain
the steps involved in three stages: (a) selection, (b) copy, and (c) paste.
Also, you can either copy multiple items or single items.

Stage-1: Select Items (Text/Tables/charts) from SPSS Output Window

Start the SPSS program. Open the data file (with extension .sav) using
the Data Editor. Perform the statistical procedure to generate the output.
As you have seen in the earlier Unit the output will be generated in the
SPSS Output Viewer window.

If you have already generated the output and saved in a output file (with
extension .spo) open the output file by selecting File->Open->Output...
command on the menu bar of SPSS Data Editor. : '
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Figure 31.30 Selecting ltems from Menu Bar of SPSS Window

in the Outline Pane of the Output Viewer window, select either single
individual item (table/text/chart) or multiple items (tables/text/chart)
you want to copy by clicking on the items. Now the Table(s)/text/
chart(s) is (are) ready for copying.

1

|
|
5

Figure 31.31 Selecting Single ‘Individualk Item
from Menu Bar of SPSS Window



. 1
Stage-2: Copy ltem(s) (Text/Table(s)/chart(s)) from SPSS Output Window:

Copying Single Item: For copying a single item, after selecting the
text/table/chart to be copied, felect Edit->Copy command from the
menu bar of SPSS Output Window. The selected item is now copied to
the Windows Clipboard.

Copying Multiple Items: For copying multiple items (text/tables/charts)
use the Edit->Copy Objects command on the menu bar. The selected
items are now copied to the Windows Clipboard. ’

Stage-3: Paste Item(s) (Text/Table(s)/Chaft(s)) into Word Document

Start the Word program. Open the Word document where you are typing
your report and want to copy the selected item(s). Select the page and
paragraph. Position the insertion point by clicking the mouse.

a) Pasting Single Items

Text Item: If the item you are pasting is a text item, select Edit->Paste
command on the menu bar. The text item is now copied from the
Windows Clipboard to your Word document at the insertion point. You
can edit the text item.

Table Item: If the item you are pasting is a table item, select Edit->
Paste Special command on the menu bar. The Paste Special dialog box
appears on the screen. Now you have three options in the dialog box.

- R T T T e S AT = i T -v—»--wv»—v——vw :‘:‘5:

Figure 31.32 Paste Special for Pasting a Table Item

Table as Formatted Text (RTF): Select Formatted Text (RTF) under As:

box in the dialog box. Click OK button. The table is now copied from the
Windows Clipboard to your Word document at the .insertion point. The
advantage of copying the tables as formatted text is that you can edit
the table or reformat the settings if needed in your Word document.
However, you may have to do some setting if needed in the table to

improve the table look. Lo L.
Descriptive Statistics

N | Minimum | Maximum | Mean [ Std. Deviation

Sex distribution 30 1 2 1.53 .507
of persons '

Marital status 30 1 3 1.80 - ,805
Valid N (listwise) | 30 '

Figure 31.33 Descriptive Statistics in Formatted Text
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Table as Unformatted Text: Select Unformatted Text under As: box in
the dialog box. Click OK button. The table is now copied from the
Windows Clipboard to your Word document at the insertion point. You
can edit the table if needed. However, you may have to adjust the tabs
to set the columns to align properly.

Descriptive Statistics

N Minimum Maximun Mean Std._ Deviation
Sex distribution
of persons 30 1 2 1.53 507
Marital status30 1 3 1.80 .805

Valid N (listwise) 30

Figure 31.34 Descriptive Statistics in Unformatted Text

Table as Picture: Select Picture under A box in the dialog box. Click OK
button. The table is now copied from the Windows Clipboard to your
Word document at the insertion point. The table is copied as an
independent graphic clip, so the text in the table can no longer be edited
by you in the Word document. The layout, font size, style, and any box
characters will automatically be preserved. The graphic can be resized
and positioned on a page within Word document. However, information
is lost when editing the graphic in Word. Therefore, if you want to
change the titles or labels or other formatting of text/table, it will be
better you do it in SPSS Output Viewer Window as we explained in

section 32.3. Descriptive Statistics

N | Minimum | Maximum | Mean | Std. Deviation
Sex distribution ‘
of persons 30 1 2 1.53 4 - .507

Marital status 30. 1 3 1.80 .805
Valid N (listwise) | 30

Figure 31.35 Descriptive Statistics as 'Picture

Paste Spetial
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Figure 31.36 Paste Special to Paste a Chart item



Chart Item: If the item you are pasting is a chart item, select Edit>Paste
Special command on the menu bar. The Paste Special dialog box appears
on the screen. Now you have three options in the dialog box. Picture
(Metafile) Object, Picture, and Bitmap. Whatever the option you choose,
you cannot do any editing in the Word document except resizing.
Therefore, we explain only Pasting as picture in this Unit.

Chart as Picture: Select Picture under As: box in the dialog box. Click
OK button. The chart is now copied from the Windows Clipboard to your
Word -document at the insertion point. The chart is copied as an
" independent graphic clip, so-the text in the table can no longer be edited
by you in the Word document. The layout, font size, style, and any box
characters will automatically be preserved. The graphic can be resized
~“and positioned on a page within Word document. However, information
is lost when editing the graphic in Word. Therefore, if you want to
change the titles or labels or other formatting of text/table, it will be
better you do it in SPSS Output Viewer Window as we explained in
section 32.2.

a) Pasting Multiple ltems

To paste multiple items, first select multiple items (as explained at
stage-1) and then copy items (as explained at stage-2), select Edit->Paste

command from the menu bar of Word window. The objects are now

copied from the Windows Clipboard to your Word document at the insertion
point. '

The text items are copied as Formatted Text and therefore you can edit
the text items. However, each table and/or chart item will be pasted as

individual Objects (Picture). Each object can be resized and positioned

on a page within Word document. However, information is lost when
editing the graphic in Word. If you want to change the titles or labels or

other formatting of table or chart, it will be better you do it in SPSS"

Output Viewer Window as we eXplained in section 32.2 and 32.3.

Reflectlon and Action 31.4
Section 31.5 has explained how to copy items generated by SPS$S into your report
that is in MS Word. Answer the following questlons

What are the three major stages in copying the SPSS output into your Word
document?

Suppose you want to copy a chart from SPSS output window into the Word-
L _document. Write the steps involved in it.

31.6 Conclusion ' -

Presentation of text, tables, and charts that you have generated using
SPSS statistical procedures in your report is very important. This is because
you can make your report more readable, analytical, and communicable
to the reader/ audience. The graphical presentation of data is one of
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the significant ways analysing the information in a more ineaningful

way. Using SPSS you can create a number of different types of chatts. In

this Unit we have introduced you to how to create and edit a simple pie"
chart and bar chart. Like your word processor program, most of the
commands in SPSS are simple, interactive,.and routine. By trying to

~ create other charts you will be able to master the SPSS program.

Using the Output Viewer window, you can edit and improve the look of
your tables. You can change the order of tables, insert new text, delete
or add items, print output, and copy the output to your report document
in MS Word. Use the Draft Viewer Window and change preset options to

.. improve the table look as per your needs before you run a procedure..
The Pivot Tables are more interactive. With pivot tables you can access

the definitions of the statistical terms used in the tables. This will help
you in interpréting the statistical results. You can also, reformat the -
tables by transposing the columns and rows, changing the order of rows
or/and columns, show or hide cells, group or ungroup the row and column

labels.

The section on copying the text/tables/charts from SPSS Output Viewer
Window to your MS Word document will help you to copy results directly
to your report without being typed again. This will save you a lot of time
and eliminate the possibility of errors in typing your report.

Remember that thére are many statistical procedures (from basic to
advanced) available in SPSS5. We did not cover all of them here as the
objective in this course is only to introduce SPSS to the students.

Further Reading,@

Davis, J. 1984. Data into Text. IN R. F. Ellen (ed.) Ethnographic Research:
A Guide to General Conduct. Academic Press: London, pp. 295- 318
(espec1ally sections 9.4 to 9.4.5 from page 308 to 314)

— & ——
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32.1 |ntroduct|on

_ In Unit 31 we have discussed the salient features of SPSS in report
writing, creating and editing graphs and analysed data by using univariate, -
-bivariate and multivariate statistics. In Unit 32, we will discuss the structure
~of report presentation with the help of information and communication
technology (ICT).

We will also mtroduce you to some cases of the presentation of research

findings with the help of audio and software for qualitative data analysis -
and presentation. The cases will help you understand the process of

applying the ICT tools. For this reason, this unit does not carry any boxes

with supplementary information. It does not also require you to complete

Reflection and Action ‘exercises as long as you are trying to follow each

case study to master the art of applying new tools for presentlng your

~ research findings. . )

32.2 Structure for Presentation of Research’
Findings ,

It is important to look carefully at the existing publications of the kind
~ you are trying to write - style, length, and format - for your writing.

The following structure shown on the next page will appnse you how to
present your findings through computer.

+153¢ .
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| Structure for a research report presentation |

-

a) Abstract . b) Background of research c) Review of related literature "
d) Research methods e) Findings f) Analysis

g) Discussion h) Conclusion i) Summary and Suggestions |
j) References k) Glossary - 1) Appendix '

Figure 32.1 Structure for Presentatibrj of Research Project Report

Before presenting your research findirlés, you need to check the following:

7

“¢  Availability and suitability of -the computer

< Availability of the electrical point

¢ Familiarity with software and hardware -

¢  You can obtain technical support, if necessary
%  Test the data-collection instrument

K/

% To see, there is clear storage and retrieval system for data

collection, etc.

Presentation of your research findings depends on your intended target
group. For example, papers or articles for journals and magazines will
be presented in different format than book chapters or final research
report. Therefore, you have to decide yourself about the format for the
presentation of your research findings. You may visit http://
www.sociology.org. uk/rrocr1.pdf for the structure of research report
on your subject area. '

32.3 Data Presentation: Editing, Coding and
Transcribing

The processes of editing, coding and transcribing are extremely important.
for the presentation of accurate research findings. If the study is
conducted through primary base data (i.e., through questionnaire), the
following steps are very important: )

Y Responses should be scrutinised for completeness and for errors.

<> Response validation is obtained by recontacting individuals whose
answers appear inconsistent or unusual.

% Open-ended questions should be properly classified or scored,
while responses to both qualitative and quant1tat1ve questions
are coded for data entry.

For a detailed treatment of these aspects see the umts in Block 6 on
Survey Research.

Editing primary data© is a fairly complex task. In fact, it requires great
skill and experience, while editing. The data should be complete,
consistent, accurate and homogenous. Quite a few steps have been
presented below for presenting primary data.



a) ‘Complete data: You should see that the answer to each and
every question has been given. If a few questions remain
unanswered, then you should mark them as ‘Not reported’ (NR).

b) Consistent data: You should see that the answers to questions
are not contradictory. If there are mutually contradictory answers,
you should try to obtain the cerrect answers either by referring
back the questionnaire or by contracting the respondent.

c) Accurate data: If the data is inaccurate, it can easily be corrected.
But, in some case, it is very difficu_lt to correct it, for example,
income and age group informed by the respondents. In this case,
we have to accept whichever the respondent gives us.

d) ; Homogenous data: You should see that informationA éupplied by
the respondents is homogenous. If it is not, it cannot be
- comparable.

Now, after making you aware of how data is edited and collected, in the
forthcoming sections we are presenting some cases and illustration of
- the presentation of research findings. In some cases, it has been presented
 with the help of the computer along with Internet and digital media.

32.4 Case Studies

““Here are four case studies for S/ou to carefully study and then taking
them as examples, you may also attempt to present your research findings
in the same manner. '

Case 1: Questionnaire Coding :
The following figure (32.1) represents the responses to the questionnaire*
which was designed to conduct a study on “the socio-economic profile of
rural people of Haryana”. The questionnaire code identification number
is 0412. To facilitate data entry, each selected individual’s four-digit
number is presented. The first number (04) indicates it is the district
code i.e. Kurukshetra. The next two digits, i.e., 1'and 2, indicate Tehsil
and Village codes. The digits within brackets indicate along with the
questionnaire the coding of the questions. This questionnaire is designed
for you to give a broad idea of coding. This is only for part of the
questionnaire.

QUESTIONNAIRE

| [Q.Code[0]4]1]2] .
| A Study of Socio-economic profile of rural people of Haryana

Q. 1Family members: (a) 3-4 (1) (b) 5-6 (2) (c) 7-8 (3)

(d) 9-10 (4) (e) >10 (5).
Q.2 Age profile: (a) below 20(1) (b) 20-25 (2) (c) 26-30 (3)

(d) 31-35 (4), (e) 36-40 (5) (f) 41-50 (6) (g)> 50 (7)
‘Q.3Gender - (a) Male (1) (b) Female (2)

Figure 32.2 Questionnaire Coding

Tabulation And Graphic
Presentation - Case Studies
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. After coding this data, ybu can present it in table (see Table ’33.1) and

graphic format. You can put this data into spreadsheet and by pressing a
few buttons (see Figure 32.3), it is possible to produce what looks like
the most wondrous variety of charts and graphs. For example, with
excel column, bar, line, pie and others are all possible to make and use in
the report presentation. ‘

Q. Code | Q1. | Q2 |1 Q3
0412 2 4 1
0413 | 3 3 0
0414 4 3 2
0415 1 3 1
0416 1 1 2
0417 3 3 1
0418 4 3 1
0420 5 0 2
0421 4 | 3 0
0422 3 3 2
0423 -2 3 1

1 4 2

4 4 1

-3 3 1

1 4 1

1 1 2

n= (230) 230 | 230 | 230

Flgure 32. 3 Coding of Questionnaire Data

Let us now look at the coded data in tabular form. See Table 32.1 on

Gender Distribution of the Respondents.

" Table 32.1 :' Gender Distr'ibution of the Respondents

Gender | Frequency | Percent
0 ‘ 4 1.73
1 82 35.49
2 144 64.01
Total 230 100.00

You-can .now convert codmg into words and your final table (see Table.
0 32.2) would look as below.

| Table 32.24: Gender Distribution of the Respondents

[ Gender Frequency | Percent
No Reply - 4 1.73
Male - . 82 ’ 35.49"
Female 144 64.01
Total 230 100.00 - ~
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Similarly, you can present the above findings into pie diagram as presented Presentation - €ave Studies

in the following figure (Figure 32.4).

No reply 2%

Male 36%

Female 62%

Frequency

Figure 32.4 Gender distribution of the respondents.

Data from the Windows can be transferred to the report on your word
processor through clipboard. If you are transferring the data from Excel
"to Word, the data will be imported already formatted as a basic Word
table, which you can then visually increase or decrease its size. Graphs
from Excel can also be transferred. to your report through clipboard,

using cut and paste.

Case II , Data collectlon and presentatlon through Audio

We are presentlng here our own experience on data collectlon and
presentation through audio. We interviewed sixty students for our research
study on drop out. Respondents’ phone numbers were located and they
were contacted to take part in a face-to-face recorded interview at
their respective home. On confirmation, we visited their homes as per
their convenience, and recorded their responses to a structured interview
schedule. :

We recorded thorough tape recorder and translated into about fifty
pages. One interview was about ene page of transcription. We were
faced with an enormous pile of -interview transcriptions each ‘of which
covered the issue of any interview schedule, but in no par_ticulér order.

Once data transcribéd, we found that we rarely returned to the tapes.

Hesitation, coughing and personal and irretevant dlscusston were indicated -
in the original transcriptions. Mﬂ\o@h twese were not used in ﬁe fmﬂ

presentation of findings, we: listened #p the tape again, it w v
different. For a micro study (or dlssemn for master program
is worth thinking carefully about whether it s necessary to compilé ;
full transcriptions of taped material or not. in fact, transgriptions M
be reserved for sections, which are partimhnty retev t to the study
The printed version and recq ; for accsilracy,
consistency and prioritization. ¥ie:
into four areas and presented in Table 32.3¢
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‘Table 32.3: Factors 'for dropout

Situational factor |, Dispositional factor

< Office work pressure (:5)"" o i'?d_preferenc’e to CIC

« Family responsibility (3) programme (1)

- ¢ Felt inferiority complex
during classes when junior
 was taking classes (1)

% Timing for practical classes
were not suitable (2)

< Got married (3) .

:%* Not aware about the exam

s Exam date clashed (9) date sheet (1)

% Not doing well
during exams (1)

% - Admission in other
programme (4)

% Husband got transferred (1) .

< Due to extended family (1)

Institutional factor - Course related factor

** Not received hall ticket (1) < Course was easy. (1)

% Study centre chgnged (5) < Coﬁrse’was difficult '(1)

% Ne information from & Language was difficult (1)
regional centre for : ) | ’

classes (4)

Source: Panda et al.' (2004) Study on Programme Comple"t'ion, and Learner
. - Persistence -and Dropowt in Distance Education, IGNOU, New Dethi

. -

Case Ili: Online case study

Research through virtual mode can be conducted through one to one e-
mail or by hosting the questionnaire on a web page. This method
provides quick feedback and access to geographically dispersed
respondents. In addition, the online interviews and e-mail messages
provided automatlc text transcripts of all the interviews and
" communications. You can
see from the following
" illustrations how research
data is presented with
virtual or digital mode®.

Figure 32.5: Presentation
of Research Findings
through Virtual Mode



Figure 32.6
Researcher editing
data through the
internet.

Figure 32.7 Presentation of research findings through multimedia.

In addit_ion to the above mode or res'earch presentation, you can also use
~ self-paced learning and.self-assessment using software/CD-Rom.

‘Case IV: Presentation of Research Findings in CD-Rom
We have presented a case study of data analysis and presentation in CD
Rom. We are giving you a CD with this unit in which you can see how the

actual data is coded, analysed and presented in the CD. The researcher

- conducted a study on “Pre-Testing Self-Instructional Material”. The
researcher c()lle;ted feedbacks from ten respondents through face to
face, analysed and presented his data research findings.

You can also present your experiment data or research findings by using
power point and interactive whiteboard. You.can eollect and disseminate
research data by using the devices of the web. But you should have
Internet and research skills for the your presentation of research fmdmgs
through the Internet.

Tabulation And Graphic
Presentation - Case Studies
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.5 Qualitative Data Analysis and Presentation

Computer Software

In dditmn to Exceli SPSS ‘and SAS, other software packages are also
available which ar being used for qualitative data analysis and
presentation, for example cornputer-aided methods for qualitative data
analysis (CAQDAS). CAQDAS. have two programmes like NUD-IST (non-
numerical, unstructured dat&f ¢ wearching theorizing) and innovative
and imaginative computer MWatlon (ATLAS.ti). The purpose
of these programmes: IS tn show that even at micro research study,

re the number c} ints ] "}’data*isﬁmﬂed these programmes may
b:ruséd. You - Can| dowaioad this software free from http://
www.scolari.co.uk

NUD-IST: This programme has more complex features, which can be
learned or ignored as the user develops familiarity with the software.
Textual data are imported into NUD-IST as separate documents. These
data can be coded which makes sense of the data. All the data under
this category (or code) can be retrieved and then turned into a separate
document. For detail you can study an lntroductory tutorial of this
software.

TMax Some pack altow direct entry into the system white others
will operate onty with fmmported files. Some allow external files
incorporating video and other material to be indexed. This makes the
programme more complex. A much more user friendly programme
is WinMax. It is easy to learn. It can be used for straightforward:
code-and-retrieve operations on text files as well as for the more
difficult approaches of grounded theory and case oriented quantification.
It also help you to work with qualitative and quantitative data
sirqultﬁnewsly. ‘

ATLAS.ti: It is an innovative and imaginative computer software
application that allows you to study and analyse text. The text can be
interview transcripts. You have to add additional coding so that it is easy
to categorize or code short or long text segments for comparative study.
For details, you may visit www.atlasti.de/demo.shtml, You can also
present you'r findings of the interview data which have been recorded on -
tape. You can analyse the audio transcripts with this software.

CAQDAS programme makes you analyse a vast amount of data to be
handled, while coding and retrieving cah now be accomplished with
remarkable speed and efficiency.

32.6 Types of ICT used for Research

In the previous units of Block 8, you have studied the application of ICTv

*in-social science research. In the present section, you will study the

different types of ICT being used in research activities. These are:



7
0‘0

Online surveys

Open ended or structured text-based interviews conducted via
email or computer-mediated conferencing

/
0‘0

< Focus groups using real time Net-based video, audio conferencing

or asynchronous computer conferencing

< Net-based telephone interviews

% Analysis of text transcripts* of learning or social activities

< Analysis of social behavior in virtual reality environments

< Online assessment and/or evaluation of performance or knowledge,
web cams. : ~

A researcher can submit his ideas through different types of ICT and
deVelOp his ideas to become full resources for use in research activities.
ICT also helps the researcher to join a discussion from where he or she
can exchange views and join in collaborative research activities. For

‘example DEOS-L@LISTS.PSU.EDU. You can present your research findings

in a suitable medium of ICT in which audience can access a full text on
the Internet in a choice of formats.

. There is no ready-made programme/software available for the analysis

and presentation of your research findings. There are various
considerations to bear in mind when matching the kind of research

“study and database to ;the most suitable software.

' The selection of the right programme depends upon the size of the

database. If you have interviewed just four to five individuals and
transcribed the text, CAQDAS may not be useful. This package handles
large quantities of data in different files much faster than you could do
it by your own hand. You should have a minimum of fifteen cases to use
this software. If data is obtained from several sources like documents,
observation, questionnaires and audio and video, some software can
handle the diversity of data types and others not. In some packages
it is easy to revise the text database, but in others revising takes

* much time. For example, a file imported into CAQDAS cannot be

changed. It would be necessary to make the changes in Word and then

~re-import the file.-

Therefore, the selection of the software depends upon the size of the

~database, nature of data (i.e. structured or unstructured), technical

Tknowledge of the researcher, time and cost.:

-Similarity, the selectlon of the IET for the presentatlon of your research

findings depends upon these factors and the. avallablllty of the ‘particular
technology to the audience.

Adobe Reader software can help you view, print, and share your research

document more securely by using a variety of platforms and devices. For

details you may visit http://www.adobe.com. There are various Web.

Tabulation And Graphic
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pages available which provide free space to share your research findings.
See, for example, www.yahoo.com. -

32.7 Conclusion

~ The fbregoing details apprise you of the cases of presentation of your .

research findings with different types of ICT sources: This discussion and

information was based on the assumption that you have a basic awareness

of the writing skill and statistical package. We have focused in this unit
on the presentation and dissemination of.your research'findings through
ICT. H'ow to code, edit and present research data has been presented in
this unit. In addition to this, how data is collected through tape recorder
and transcripted lnto text are also presented.

Further Readingg

Gentleman, Jarie F. 2004. The National Health Interview Survey. In
National Health Interview Survey Presentations of the 2004 Listing of
Selected Presentations at http://www.cdc.gov/nchs/howto/events/
duc2004/ducpresentations 2004.htm
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Learning Objectives &<

It is expected that after reading Unit 33, you would be able to get the

follow1ng guidance to successfully complete one of the assignments of

MSO 002. - ' _

Obtain an overview of the course material of MSQ 002.
Understand the objectives of undertaking a research project.
Begin preparations for planning and carrying out the research
project.

Work out the various stages of the research. -

- Seeking help to overcome problems, if any, during the research.
Be informed about the submission and evaluation methodology of
the research prOJect

L)
0.0

)
.0

D)

)
.0

D)

X) R/
0.0 0.0

33. 1 Introduction

| hope that you have r_ead in-Book 1 the Introduction to MSO 002, where
we mentioned on page xii ‘that the first tutor marked assignment of
MSO 002 would comprise a 5,000-word report on a small fieldwork-based
research project on one of the subjects listed in the assignment bocklet
of MSO 002. Alternatively, you may choose your own subject of research.
Unit 33 aims to provide you some guidelines-to research project
assignment. In addition, you may consult your academic counsellor at
the Study Centre assigned to you.

33.2 Overview of Reséarc'h Methodologies and |
Methods (MSO 002)

It is useful to repeat what you have already read in Book 1 about
organisation of the course material of MSO 002. This will provide a bird’s

eye view of what you have already read in MSO 002 and it is expected
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that you will now be ‘able to put into practice what you have learnt in the -
pages of MSO 002 course material. As explained earlier, the objective of
MSO 002 is to train its learners to become good researchers and.
investigators of the social reality around us. '

All attempts to make social research scientifically valid involve clarity of -
perspectives or orientations that guide one’s quest for collection of facts
and all such clarity is worthwhile only when it accompanies scientific .
methods and techniques of collecting and analysing/ interpreting facts.
Then comes the documentation and presentation of one’s analysis in -
technical summaries and reports or research publications. Following this
very sequence, the second course of M.A. Sociology of IGNOU, (MSO

- 002) has been divided into three books.

< Book 1, Research Methodologies: Book 1 traces the philosophical

* roots of current methodologies in social research and sensitises its learners

to take a critical look at them for obtaining conceptual clarity. It has
three blocks, with eleven units.

18 Book 2, Quantitative and Survey Methods: Book 2 deals with
the study of a) research methods as a way to understand social phenomena
and b) statistical and survey methods of gathering, organizing and analysing
the data collected.

< Book 3, Qualitative Methods and Presentation of Research
Findings: Book 3 is concerned with qualitative methods of research and
writing up the flndmgs of the research. In addition, as-a novel input to a
research methods course, the book covers the applications of the tools
that information technology has made available to social science
researchers for analysing and presenting their research data.

Having completed your reading of the units in the three books of MSO
002, you are now fully sensitised to the need of critically looking at
different perspectives, methods and techniques of social research. You
have reached the stage when you can receive an exposure, however
limited, to fieldwork that would inculcate in you the spirit of inquiry
through real life experience of soCiological research. :

33.3 Research Project ‘Objec'tfives

- The objective of the Research Project is to provide you with an opportunity

to utilise the knowledge and apply the skills gained from the three books
of ‘MSO 002 so that you may be able to use social science research

-methodologies-and methods in the world of work and for pursuing research

degrees like M. Phil. and Ph. D. in the social sciences. You would need to
read the contents of the three books in detail from the point of view of
the subject of your research project. You would study in depth the :
relevant theoretical foundations, appropriate methods and techniques
for carrying out field research in order to generate your own data. In



the process, you may come across constraints at any stage of your
research project. You would need to overcome those constraints and
present the results of your research in about five thousand words. This
discussion would take us to the next section of this unit, that is, preparing
for the research project.

33.4 Preparation for Research Project

Here we give, in brief, the main stages of the research project and in
the next section you will read their details.

+ The planning stage

This stage begins as soon as you enrol for MSO 002. The effort you put
into your research project would be optimum if you work systematically.
Some of the steps that you need to follow are listed in the next section
for your reference. Just to start with a few of them are

a) Start a diary or a logbook to systematically record the process

and activities you undertake throughout the research project.

b) Identify and determine the theme for your research project within
“six to ten weeks of receiving your learning material of MSO 002
by browsing through each of the three books.

e) Start making entries in your diary/ logbook@. This will help you in
later stages of your research.

d) Consult the academic counsellor and discuss with her/ him the
feasibility of carrying out your research.

e) Give yourself some degree of flexibility for changing your research
topic. This should of course be done keeping in mind the time
and resources available at your end.

f) . Visit the libraries close to the place of your residence for consulting
' the books in the reading list suggested by the social scientists you
had spoken to.

~ The above steps would be enough to get going with your research project.
You would now be ready for the second stage of your research.

¢ Working on the Research Pro;ect
a) Getting an ovemew of your research project through a review of
‘ secondary data®

b) Contextualismg general observations with the objectives 6f your
research project

) Description of case study projects, if any

d) Identifying the key actors/ informants/ participants and ‘their
social networks

e) Selecting method(s) for data gathering and analysis

Guidelines to Research
Project Assignment
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f) ~Data analysis
g) = Drawing conclusion$

After working on your research prdject will come the stage of putting it
down on paper or let us say that this is the stage of writing up your
material.

*» Research Project Report
a) Writing or typing the report
b) Selecting the format of the report

' C) Organisfng accordingly the presentation of the data and its analysis.

Going through the above three stage of the research project will see you
build a capacity for-conducting a social research. We will now discuss in
detail all stages of research including the above three mentioned in this
section.

33.5 Stages of the Research Project

The discussion in this section is to give you guidelines so that you are
able to carry out the research in a systematic and confident manner
without-any apprehension and fear of failure. Let us begin with the first
stage.

< Stage 1: Planning stage

At the planning stage, you will need to accomplish the following four tasksk
in a careful manner. This is so because good planning is likely to provid_e_
you a clear and concise understanding of what you are going to-do.’

i) Work out a timetable for completing the reading of the three
books of MSO 002. Along with this task, plan your timetable for carrying
out all your assignments and make a.conscious effort to maintain your
work progress as planned. Make sure to assign some time for research
prOJect in your timetable, '

ii) Explonng options for individual research project would entall the
following steps. '

a) You would need to explore options for an appropriate topic
from the list in the assignment booklet. Because of the time
constraints and demands of your other than study responsibilities,
like a job, family obligations etc, it would be most appropriate if .
you select a research topic that is contextualised in the area of
your work or residence. In this matter you need to first decide
your area of .interest, for example, environment, ecology, natural
resources,. education, minority communities, socially marginalised
groups, girl child, working women, family, marriage and kmshlp
etc. (the list can be a really long one).



b)  After selecting the theme or an area of your interest, you can
proceed to determine the nature and location of your research. As
per your convenience you need to conduct field research in a manner
that does not make a heavy demand on your time, energy and
resources as you have many other tasks to complete during the
course of your study at IGNOU.

¢) The next task is to determine the extent, quality and type of
secondary data available, as there has to be ample background
information on your research topic to give you an understanding
of the social processes involved in taking the situation to its current
state. This would require you to collect secondary data from various
sources. You only need adequate data to get a clear picture of the
current status of the social situation so that you can contextualise
.your own research project.

iii) Making an arrangement with the academic counsellor at your Study
Centre to seek help and advice when you feel the need for a discussion
on your research or when you find that you are facing some difficulty in
carrying out your research.

iv)  Preparing a research proposal. This needs to be a brief statement
with the following heads. :

a) Title of Research Project

b)  Purpose and Objectives of Research
¢) Research Methods

d) Time Frame

You can discuss the research proposal with your academic counsellor and
consider it once more from the point of view of the time and resources
available to you for completing the research. Make modifications, if any,
at this stage and once you have begun working on it make efforts to
stick to your plan. If you keep making changes again and again, you will
waste time, energy and resources without achieving much. The evaluation
of this assignment will focus on the efforts made by you rather than on
achieving a superbly finished product. That you may do after completlng
your master’s programme in sociology.

¢

%  Stage 2: Actual Carrying out of Research

The details of the following depend mostly on the type of research you
undertake. Here are the five steps you can take in order to execute
your research plans.

i) Determine data requirements
The data you will require will relate to

a) Relevant Acts and policies, if any, existing about the topic of your
research

b) Maps and other visual materials

Guidelines to Research
Project Assignment
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c) Census enumeration of the general/ particular area of research

d). Socio-economic survey of sample population to prepare a profile of
the people

e) Socio-cultural, economic and political issues identified through
participatory methods

f) Institutional structure, procedures and processes

g) Case-study or extended method report to reflect social change
and/ or conflict

iil) Prepare for data collection

You need to find out if there is existing data available on the topic of your
research and whether it would be suitable for your research project. It is
necessary to determine and record who collected the data, when it was
collected and how reliable the information is. You need to remember to
note the following details about every source of information you refer to

a) Full title of thé document, book, journal, map, etc

b)  Author, department, agency that has prepared the document, book,
journal, map etc

c) Date/ year when the document, map, etc , was prepared
d) Date/ year when the document, book, journal, map was published
e) Edition, place of publication and publisher for books and articles

After this initial exercise, determine the specific requirements for
additional data that may pertain to both primary and secondary data for

‘achieving the objectives of your research.

iii) Identify secondary data sources

Sources can range from newspapers, books, and articles to specialists in
the area of your research in public life, administrative bureaucracy, and
the Internet search options.

iv) Data collection and methods

Before you begin data collection, review the requirements you have
identified for primary data and discus with the academic counsellor
about the need to collect primary data. Clearly define what you need
and for what objectives. Then determine the most appropriate data
collection method. It is necessary to go through the following steps in
order to ensure that the data analysis presented in your research project
report is reliable. For this purpose you need to explain and justify

a)  The design of the survey questionnaire form or the appropriateness
and selection of participatory technique or tools used for specific
data collection

b)  Method of field work including how persons helping in your research
were identified and how they were briefed/ trained to help you
with the survey work



¢)  Process followed for field supervision and/ or recording, verification
and quality control

d) How data was processed, including use of any computer software
packages and how it was analysed

/7

% Stage 3: Research Project Report

Once you have collected data and analysed them, you will need to prepare
the report by systematically reporting your work as per the following
steps.

i) Report components
The research project report has the following two components.

a) The logbook or diary that you maintained as an aid for actual
preparation of the report (this is only as an evidence of your
systematic pursuit of your research)

b) The written report and the documentation in a medium of your
choice, including written text, video film, photographs etc

ii) Report format and organisation
The format of report and documentation needs to follow the structure
given below.

a) Cover page: The first page of the report is to indicate the titles of

your research project, name and location of the place where
fieldwork was carried out and your name with your enrolment
number. :

b)  The second page is to carry a summary of your reseaifch project in -

less than 300 words.

¢) The third page is to give acknowledgements -

d) The fourth page is to list alphabetically a list of abbreviations

e) The fifth page is to provide the table of contents, including list of
tables, maps and figures/ illustrations

f)  From the sixth page onward, you need to give first an introduction
to your research project, its approach, including key issues that
determined selection of the research project

g) Next in order of presentation will be the description of techniques
or methods adopted for data collection and analysis

h)  Then would come stating findings from your research

i) After stating the findings, you need to put down the conclusions
drawn.

j)  Inthe end, you need to give a list of references in the manner you
find in the three books of MSO 002. This means that the list should

be arranged alphabetically by the author's surname followed by

initials or forename(s) and the year of publication of the particular
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book/ article/ other document, full title of the document, which
has to be italicised. This should be followed by the name of the
- publishing firm and place of publication. You need to take care to
mention the sources of data or quotations, whether from books,
journals, other published and unpublished documents and websites
referred to in the research project report. Please note that this is
an important aspect of your research project assignment and take
care to pay atténtion to this in order to obtain better grades.

k)  Please keep in mind that when abbreviating names of organisations,
terms etc in the written text, provide the name in full form when
you mention it for the first time with the abbreviated form in
brackets. Subsequently, use the abbreviated form. All abbreviations
in the text should be listed on the fourth page of your report along
with their full forms stated.

iii) Language and editing

The research project report is to be written in the language that has
been opted for by you for completing MSO 002. All the report material
like photographs, films, etc, should have the same language scripts. It is
a very good idea to write the first draft and then edit it both in terms of
its content and language. You may also like to give it to your co-learners
of MSO 002 for their comments and suggestions for modifications and
you may extend a similar gesture to them. This will help you to refine
the presentation of your report.

33.6 Supervision During the Research Project

You will be basically working on your research project on your own but
you can always discuss your problems with the academic counsellor at
your study centre as well as with your co-learners. There is no formal
arrangement for supervision of this practical exercise of MSO 002. You
are required mainly to consult the course material of MSO 002 and carry
out your research at a modest level so that this exercise gives you a
taste of what it is like to do research. You need not make it a too time-
consuming and lengthy exercise.

33.7 Submission of Research Project

The written report should be submitted on A4 paper size format, typed
in double spacing in a bound volume. The length of the report should be
five thousand words, excluding appendices, other documents.

The report should be submitted at the Study Centre in the same manner
as you would submit other assignments. Do not forget to retain a copy
of the report with you. Obtain an acknowledgement receipt after

submission of the report at the Study Centre.



If you allow your research work report to be copied by your co-learners
for submission as their reports, you and those who submit such copies
would be disqualified and you and others will have to work all over again
and produce another piece of work. '

33.8 Methodology for Evaluating Research
Project

Evaluation methodology of research project report is as follows.

The evaluation will be done at the Study Centre by the same evaluator
who would evaluate other assignments of MSO 002. The assignment of
the research project will carry a weight similar to assignment 1 of other

courses of Master’s Programme in sociology. The per cent of total marks
of this assignment will be distributed as given in Box 31.1.

m
Box 31.1 Distribution of total marks of Assignment 1 of the Research

Project ‘
i)  Diary or logbook documenting the process of fieldwork-based research 20
per cent

i) Clarity of topic, language, coherence, style etc 20 per cent
iiiy Clarity of objectives and methodology as well as methods 20 per cent
v)  Understanding and practice of fieldwork-based research 20 per cent

v)  Extent to which the learnihg objectives of the each of the three books of
MSO 002 are reflected in the body of the research project report 20

per cent. ‘
B e e _____}

33.9 Conclusion
Unit 33 has provided you guidelines to undertake a mini research project

as one of the assignments of MSO 002. The inputs in this unit are

considered to be fairly adequate for the need of carrying out a fieldwork-
based research of modest proportions.

In case, you face problems in completing this assignment, you are
recommended to consult your academic counsellor and/ or the co-ordinator
of MSO 002 at headquarters in IGNOU, Maidan Garhi, New Delhi.

| wish you best of luck for completing the assignment and also the full
course of MSO 002. '

Further Reading@

Read once more your own research project' and try to improve it in
terms of style, language and substantive content.
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Glossary

(Explanations of glossary words have been prepared with the help of information available
on the Internet and in other sources.)

Animations: The word refers to the act, process, or result of imparting life, interest,
spirit,motion, or activity. In the context of the MSQ 002 text, it refers to the art or
process of preparing animated cartoons.

Anonymisation: It refers to the process of giving pseudonyms to persons/ places in
order to hide their identity. This is a regular practice among social scientists who often
work on sensitive topics and disclosing the identities of real persons/ places may in
some cases give rise to problems of moral and ethical nature and in such circumstances
taking recourse to anonymisation may be necessary.

Bar Charts: Bar Charts, like pie charts, are useful for comparing classes or groups of
data. In bar charts, a class or group can have a single category of data, or they can be
broken down further into multiple categories for greater depth of analysis. Bar charts
are famitiar to most people, and interpreting them depends largely on what information
you are looking for. You might look for:

<& the tallest bar.

A
L X2

the shortest bar.

<

growth or shrinking of the bars over time.

O
0.0

one bar relative to another.
< change in bars representing the same category in different
< classes

Watch out for inconsistent scales. If you’re comparing two or more charts, be sure they
use the same scale. If they don’t have the same scale, be aware of the differences and
how they might trick your eye.

Be sure that all your classes are equal. For example, don’t mix weeks and months, years
and half-years, or newly invented categories with ones that have trails of data behind
them.

Be sure that the interval between classes is consistent. For example, if you want to
compare current data that goes month by month to older data that is only available for
every six months, either use current data for every six months or show the older data
with blanks for the missing months.

For each bar in the bar chart, the following statistics are useful:

Mean the average height of all the bars.

Maximum the maximum value (tallest bar) in the series.
Minimum the minimum value (shortest bar) in theb'series.
Sample Size the number of values (bars) in the series.

Range the maximum value minus the minimum value.

Standard Deviation | Indicates how widely data is spread around the mean.

Bivariate: The term refers to the fact of having two variables, for example bivariate
binomial distribution. ‘

Boolean: The term refers to a logical combinatorial system treating variables, such as
propositions and computer logic elements, through the operators AND, OR, NOT, and



XOR, a browser that supports Boolean searches. It relates to a data type or variable in
a programming language that can have one of two values, true or false.

The term is named so after George BOOLE.

Browser or Web browser: it is the program that serves as your front end to the Web on
the Internet. In order to view a site, you type its address (URL) into the browser’s
Location field; for example, www.computerlanguage.com, and the home page of that
site is downloaded to you. The home page is an index to other pages on that site that
you can jump to by clicking an underlined hyperlink or an icon. Links on that site may
take you to other related sites.

Browsers have a Bookmark or Favorites feature that lets you store references to your
favorite sites. Instead of having to type in the URL to visit the site again, you select the
bookmark. It Started with Mosaic. The Mosaic browser put the Web on the map in 1993,
but by the mid 1990s, Netscape Navigator (commonly called “Netscape”) had 80% of the
market. Vying for top spot, Netscabe and Microsoft’s Internet Explorer (IE) constantly
added new features and functions that fragmented Web sites into competing camps.
Today, IE, which is included with every Windows PC, has approximately 90% of the market.
Netscape is still popular among devotees, and it wound up spawning Mozilla and Firefox,
the latter gaining a lot of attention when released in 2004. Opera also has a nice
following, and Safari is the browser for Mac 0S X.

When a site says “best viewed by Netscape” or “best viewed by Internet Explorer,” it
means that the pages were programmed for that particular browser. Using the other
browser will ignore some of the page’s visual features until a subsequent release supports
them. See Mosaic, Opera, Mozilla, Firefox, Safari, hyperlink, World Wide Web, HTML and
microbrowser.

Chi-square test: Chi-square test is a test that uses the chi-square statistic to test the fit
between a theoretical frequency distribution and a frequency distribution of observed
. data for which each observation may fall into one of several classes.

“Clickability”: Clickability works with organizations online who want to generate revenue,
reduce costs, and strengthen relationships with their audience. Clickability provides
solutions and tools for enhancing user interactivity, managing content, and improving
navigation. :

Code: As a noun the word refers to the stuff that software writers write, either in
source form or after translation by a compiler or assembler. Often used in opposition to
“data”, which is the stuff that code operates on. Among hackers this is a mass noun, as
in “How much code does it take to do a bukble sort?”, or “The code is loaded at the
high end of RAM.” Among scientific programmers it is sometimes a count noun equivalent
to “program”; thus they may speak of “codes” in the plural. Anyone referring to software
as “the software codes” is probably a newbie or a suit.

In the sense of writing a code, the word always refers to source code rather than
compiled. “l coded an Emacs clone in two hours!” This verb is a bit of a cultural marker
associated with the Unix and minicomputer traditions (and lately Linux); people within
that culture prefer the verb ‘code’ to the verb ‘program’ whereas outside it the reverse
is normally true. .

In communications, a code is a rule for corwverting a piece of information (for example,
a letter, word, or phrase) into another form or representation, not necessarily of the
same sort. '

In the history of cryptography, codes were ance common for ensuring the confidentiality
of communications, although ciphers are now used instead.

Codes in communication are used for breevity: Code can be uséd for brevity. When
telegraph messages were the state of the art in rapid long distance communication,
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elaborate commercial codes which encoded complete phrases into single words
(commonly five-letter groups) were developed, so that telegraphers became conversant
with such “words” as BYOXO (“Are you trying to weasel out of our deal?”), LIOUY (“Why
do you not answer my question?”), BMULD (“You’re a skunk!”), or AYYLU (“Not clearly
coded, repeat more clearly.”). Code words were chosen for various reasons: length,
pronounceability, etc. Meanings were chosen to fit perceived needs: commercial
negotiations, military terms for military codes, diplomatic terms for diplomatic codes,
any and all of the preceding for espionage codes. Codebooks and codebook publishers
proliferated, including one run as a front for the American Black Chamber run by Herbert
Yardley between WWI and WWII. The purpose of most of these codes was to save on
cable costs. The use of data coding for data compression predates the computer era;
an early example is the telegraph Morse code where more frequently-used characters
have a short representation. Techniques such as Huffman coding are now used by °
computer-based algorithms to compress large data files into a more compact form for
storage or transmission.

Coding: Coding means to systematise and arrange (laws and regulations) into a code or
to convert (a message, for example) into code. In Computer Science coding refers to
write or revise a computer program. In communications and information processing,
encoding is the process by which a source (object) performs this conversion of
information into data, which is then sent to a receiver (observer), such as a data
processing system. Decoding is the reverse process of converting data, which has
been sent by a source, into information understandable by a receiver.lt is an
implementation of that rule (or algorithim) for coding and decoding, for example MP3,
which may be a hardware implementation or a software implementation, and which
may include compression. '

One reason for coding is to enable communication in places where ordinary spoken or
written language is difficult or impossible. For example, a cable code replaces words
(e.g., ship or invoice) into shorter words, allowing the same information to be sent with
fewer characters, more quickly, and most important, less expensively. Another example
is the use of semaphore flags, where the configuration of flags held by a signaller or the
arms of a semaphore tower encodes parts of the message, typically individual letters
and numbers. Another person standing a great distance away can interpret the flags
and reproduce the words sent. '

Consistency: It refers to condition of adhering together or firmness of material substance.
In the .context of units of MSQ 002, the word refers to ability to be asserted together
without contradiction or agreement or harmony of parts or features to one another or
a whole.

Content analysis: Content analysis (also called: textual analysis) is a standard methodology
in the social sciences on the subject of communication content. Harold Lasswell
formulated the core questions of content analysis: “Who says what, to whom, why, to
what extent and with what effect?”. Ole Holsti (1969: 14)) offers a broad definition of
content analysis as “any technique for making inferences by objectively and systematically
identifying specified characteristics of messages”.

The method of content analysis enables the researcher to include large amounts of
textual information and identify systematically its properties, e.g. the frequencies of
most used keywords (KWIC = Keyword In Context) by detecting the more important
structures of its communication content. Yet such amounts of textual information must

. be categorised according to a certain theoretical framework, which will inform the

data analysis, providing at the end a meaningful reading of content under scrutiny.
David Robertson (1976: 73-75) for example created a coding frame for a comparison of
mades gof paFty compgtition petween British and American Parties. It was developed
further in 1979 by the Manifestg Researeh Growp aiming at a comparative content-
anglytie appreach on the policy positiens af Bglm‘égl parties. This classification scheme



was also used to accomplish a comparative analysis between the 1989 and 1994 Brazilian
party boadcasts and manifestos by F. Carvalho (2000).

The creation of coding frames is intrinsically related to a creative approach to‘variables
that exert an influence over textual content. In political analysis, these variables could
be political scandals, the impact of public opinion polls, sudden events in external
politics, inflation etc. Mimetic Convergence, created by F. Carvalho for the comparative
analysis of electoral proclamations on free-to-air television is an example of creative
“articulation of variables in content analysis. The methodology describes the construction
of party identities during long-term party competitions on TV, from a dynamic perspective,
governed by the logic of the contingent. This method aims to capture the contingent
logic observed in electoral campaigns by focusing on the repetition and innovation of
themes sustained in party broadcasts. According to such post-structuralist perspective
from which electoral competition is analysed, the party identities, ‘the real’ cannot
speak without mediations because there is not a natural centre fixing the meaning of a
party structure, it rather depends on ad-hoc articulations. There is no empirical reality
outside articulations of meaning. Reality is an outcome of power struggles that unify
ideas of social structure as a result of contingent interventions. In Brazil, these contingent
interventions have proven to.be mimetic and convergent rather than divergent and
polarised, being integral to the repetition of dichotomised worldviews.

The Process of a Content Analysis
According to Klaus Krippendorff (1980 and 2004), six questions must be addressed in
every content analysis: :

R Which data are analysed?

L2 How are they defined?

L4 What is the population from which they are drawn?

w What is the context relative to which the data are analysed?
< What are the boundaries of the analysis?

~ What is the target of the inferences?

According to Zipf Law, the assumption is that words and phrases mentioned most often
are those reflecting important concerns in every communication. Therefore, quantitative
content analysis starts with word frequencies, space measurements (column centimetres
in the cuse of newspapers), time counts (for radio and television time) and keyword
frequencies. However, content analysis extends far beyond plain word counts, e.g. with
KWIC routines words can be analysed in their specific context to be disambiguated.
Synonyms and homonyms can be isolated in accordance to linguistic properties of a
language. Qualitatively it can involve any kind of analysis where communication content
(speech, written text, interviews, images) is categorised and classified. While on its
start with the first newspapers at the end of 19th century, it was done by manually
measuring the amount of lines and space e.g. on newspapers. With the rise of common
computing facilities like PCs, computer based methods of analysis are growing in popularity.
Answers to open ended questions, newspaper articles, political party manifestoes,
medical records or systematic observations in experiments can all be subject to systematic
analysis of textual data. By having contents of communication available in form of machine
readable texts, the input is analysed for frequencies and coded into categories for
building up inferences. Weber (1990: 12-14) notes: “To make valid inferences from the
text, it is important that the classification procedure be reliable in the sense of being
consistent. Different people should code the same text in the same way”. The validity,
Inter-coder reliability and Intra-coder reliability are subject to intense methodological
research efforts over long years (see Krippendorf, 2004).

One more distinction is between the manifest contents (of communication) and its
latent meaning. “Manifest” describes what (an author or speaker) definitely has written,
while latent meaning describes what an author intended to say/write. Normally, content

e
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analysis can only be applied on manifest contents, that. are the words, sentences, texts
in general.

A further step in analysis is the distinction between dictionary-based (quantitative)
approaches and qualitative approaches. Dictionary-based approaches set up a list of
categories derived from the frequency list of words and control the distribution of
words and their respective categories over the texts. While methods in quantitative
content analysis in this way transform observations of found categories into quantitative
statistical data, the qualitati-e content analysis focuses more on the intentionality and
its implications.

Copycat: One that closely imitates or mimics another. When used as an adjective, the
word refers to closely imitating or following another: a copycat version of a successful
product; a copycat crime.

Cursor: In Computer Science the word means a bright, usually blinking, movable indicator
on a display, marking the position at which a character can be entered, corrected, or
deleted.

Cyber café: The words refer to a cafe from which customers can access the Internet.
It refers also to a chatroom.

Database: A collection of data arranged for ease and speed of search and retrieval. Also
called data bank.

Debriefing: The term refers to the act or process of debriefing or of being debriefed or
the information imparted during the process of being debriefed.

Demographers: The word refers to persons who engage in the study of the characteristics

. of human populations, such as size, growth, density, distribution, and vital statistics.

Diachronic: The word is concerned with phenomena, such as linguistic features, as
they change through time. The word is used to describe the study of a phenomenon as
it changes through time,

Dialectic: The history of the term dialectic would by itself constitute a considerable
history of philosophy. Briefly, the term “dialectic” owes much of its prestige to its role
in the philosophy of Plato, where it figures as the logical method of philosophy in the
Socratic dialectical method of cross-examination. The term was given new life by Hegel,
whose dialectically dynamic model of nature and history made it, as it were, a fundamental
aspect of the nature of reality (instead of regarding the contradictions into which
dialectics leads as a sign of the sterility of the dialectical method, as Kant tended to do
in his Critique of Pure Reason). In the mid-nineteenth century, the concept of “dialectic”
was appropriated by Marx (see, for example, Das Kapital, published in 1867) and Engels
and retooled in a non-idealist manner, becoming a crucial notion in their philosophy of
dialectical materialism. Thus this concept came, for a time, to play a prominent role on
the world stage and in world history. Today, “dialectics” can also refer to an understanding
of how we can or should perceive the world (epistemology), an assertion of the
interconnected, contradictory, and dynamic nature of the world outside our perception
of it (ontology), or a method of presentation of ideas or conclusions. Basically, it is the
art or practice of arriving at the truth by the exchange of logical arguments.

Dialog: Dialog refers to the first commercial online information retrieval system, created
by Roger Summit in 1967 and launched as a service in 1972. For years, DIALOG has
offered the largest single collection of information available online, claiming over 900
databases in areas such as business, science, finance and law. Searching is free, but
there are fees for viewing the results. Access is available via the Web or by separate dial-
up numbers as was the norm before the Internet became popular. DIALOG’s searchable
content is considered to be part of the deep Web

Digital mode: The word “digital” is commonly used in computing. A digital system is one
that uses discrete values rather than a continuous spectrum of values: compare analog.



The word comes from the same source as the word digit: the Latin word for finger
(counting on the fingers) as these are used for discrete counting.

The distinction digital versus analog can refer to data storage and transfer, the internal
working of an instrument, and the kind of display. A system working with discrete values
would be described as bring in digital mode.

Discourse analysis: Discourse analysis is any of a number of approaches to analysing
language use beyond the sentence or clause level. The language in question can be
written or spoken texts or systems of texts. The term discourse analysis first entered
general use in a paper published by Zellig Harris in 1952.

The concept of discourse analysis has been taken up in a variety of disciplines, including
linguistics, anthropology, sociology, and social psychology, each of which is subject to
its own assumptions and methodologies. The following are some of the specific theoretical
perspectives and analytical approaches used in linguistic discourse analysis:

< Interactional sociolinguistics

< Ethnography of communication

< Pragmatics, particularly speech act theory

< Conversation analysis, which is based on the theories of Harvey Sacks
< Variation analysis

2] Discursive psychology, particularly as developed by Jonathan Potter.

Critical discourse’ analysis combines discourse analysis with critical theory (particularly
that of the Frankfurt School and Michel Foucault, as well as literary, semiotic and

" psychoanalytic influences from Julia Kristeva, Roland Barthes, and Jacques Lacan), to
create a politically engaged form of linguistic discourse analysis.

Although each approach emphasises different aspects of language use, they all view
language as social interaction, and are concerned with the social contexts in which
discourse is embedded. In the social sciences discourse analysis has come to occupy a
significant place.

Elicitory: The word means to bring or draw out (something latent); ¥duce. It also means
to arrive at (a truth, for example) by logic or to call forth, draw out, or provoke (a
reaction, for example).

Ethnographer: Ethnographer is a person who engages with the brancj_w of anthropology
that studies the scientific description of specific human cultures.

Ethnomethodology: It is the branch of sociology that deals with the codes and
conventions that underlie everyday social interactions and activities.

Fieldwork: Fieldwork is the work done or firsthand observations made in the field as
opposed to that done or observed in a controlled environment. In the context of the
units of MSO 002 the word refers to the collecting of sociological or anthropological
data in the field.

Folklorist: The word means a person who engages in the study of traditional customs,
tales or sayings preserved orally among a people. Eolklore is a comparative science that
investigates the life and spirit of a people as revealed in their folklore.

Footnote: Footnote is a note placed at the bottom of a page of a book or manuscript
that comments on or cites a reference for a designated part of the text.. It is something
related to but of lesser importance than a larger work or occurrence: for example, a
political scandal that was but a footnote to modern history. As a verb it is used to
denote furnishing with or comment on in footnotes.

Foucault: Foucault, Michel (1926-1984) was a French philosopher and historian who
explored the role played by power in shaping knowledge. His works include Madness
and Civilization (1961) and the multi-volume History of Sexuality (1976-1986). He was
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professor at the Collége de France (1970-84).

Gatekeepers: The word refers to those in charge of passage through a gate. In the
context of the units of MSO 002, it refers to those who monitor or oversee the actions
of others and are therefore important persons of the community (proposed to be the
subject of study by a sociologist/ anthropologist).

Glacier: The word refers to a huge mass of ice slowly flowing over a land mass, formed
from compacted snow in an area where snow accumulation exceeds melting and
sublimation.

Grounded theory: It is a general research method for behavioural science developed by
two sociologists. One was Barney Glaser (b. 1930), who was trained in quantitative
sociology by Paul Lazarsfeld. The other person was Anselm Strauss (1916-1996), who was
trained in symbolic interactionism by Herbert Blumer. The successful collaboration of
Glaser and Strauss in research on dying in hospitals evolved into the “constant comparative
method”, or grounded theory (GT). The name underscores the generation of theory from data.

GT is the most quoted method by researchers doing qualitative data analysis in the
world according to database searches (Google, Medline, CINAHL, Psyclit, Econlit).

Most chapters in the first GT methodology “The Discovery of Grounded Theory” (Glaser
& Strauss, 1967) were written by Glaser, trained in methodology generation. Glaser
alone wrote the second methodology “Theoretical Sensitivity” (Glaser 1978) and has
since written five more books on the method and edited five readers with a collection
of GT articles and dissertations. The Grounded Theory Review is a peer-reviewed journal
publishing grounded theories and articles on different aspects of doing GT.

Strauss and Juliet Corbin (Strauss and Corbin 1990) took GT in a different direction from
what Glaser had outlined in Theoretical Sensitivity and the 1967 book. There was a clash
of ideas between the discoverers and Glaser in 1992 wrote a book arguing against the
Strauss and Corbin book chapter by chapter. Hence GT was divided into Strauss and
Corbin’s method, and Glaser’s GT with the original ideas from 1967 and 1978 still in
operation. - 1

Hardware and software: Though in general hardware refers to metal goods and utensils
such as locks, tools, and cutlery, in Computer Science it refers to a computer and the
associated physical equipment directly involved in the performance of data-processing
or communications functions. Software refers to the programs, routines, and symbolic
languages that control the functioning of the hardware and direct its operation.

Histogram: It is a bar graph of a frequency distribution in which the widths of the bars
are proportional to the classes into which the variable has been divided and the heights
of the bars are proportional to the class frequencies. It is a charting format that displays
horizontal or vertical bars. The length of the bars is in proportion to the values of the
data items they represent. Many digital cameras use histograms to display the brightness
of the image. Using 256 vertical bars to represent brightness levels from 0 to 255, the bar
on the leftmost side of the chart is the darkest pixel level (0), and the rightmost bar is
the lightest (255). The height of the bars represents the relative number of pixels in the
image that contain that brightness level.

HTML: HTML is a markup language used to structure text and multimedia documents
and to set up hypertext links between documents, used extensively on the World Wide
Web. It is an acronym for Hyper Text Markup Language.

Imponderabilia: The term refers to that cannot undergo precise evaluation: imponderable
problems.

Institution: In the context of the units of MSO 002, the term refers to a custom,
practice, relationship, or behavioural pattern-of importance in the life of a community
or society, for example, the institutions of marriage and the family.



In general terms, the word means an established organisation or foundation, especially
one dedicated to education, public service, or culture.

Interpretative social science: The second theme of Schutz’s theory of the cultural
sciences is the clarification of the categories or “basic concepts” of the sciences. To
show what this is about, it is most efficient merely to quote the list on the first page of
Schutz’s Aufbau of the basic concepts of interpretative sociolology that he then attempts
to clarify in his book: “the interpretation of one’s own and others’ experiences, meaning-
establishment and meaning-interpretation, symbol and symptom, motive and project,
meaning-adequacy and causal adequacy, and, above all, the nature of ideal-typical
concept formation.” Investigation beyond Schutz’s work should pursue similar concepts
in other disciplines, beginning from the science-theoretical reflections of the scientists
themselves while always being prepared to go further.

Interpretative sociology or verstehen: Interpretative Sociology (or verstehen, a German
word for understanding, pronounced as though it rhymes with fair-stain) was used by
Max Weber to describe a process in which outside observers of a culture (such as
anthropologists) relate to an indigenous people on the observer’s own terms. This concept
has been both expanded and criticized by later social scientists. Proponents laud this
concept as the only means by which researchers from one culture can examine and
explain behaviours in another. While the exercise of verstehen has been more popular
among social scientists in Europe such as Jirgen Habermas, verstehen was effectively
introduced into the practice of sociology in the United States by Talcott Parsons, an
American follower of Max Weber. Parsons incorporated this concept into his 1937 work,
The Structure of Social Action.

Critics of verstehen such as Mikhail Bakhtin and Dean MacCannell counter that is simply
impossible for a person born of one culture to ever completely understand another
culture, and that it is arrogant and conceited ta attempt to interpret the significance
of one culture’s symbols through the terms of another (supposedly superior) culture.

IP address: IP address is an acronym for Internet Pratocol address, which is the address
of a device attached to an IP network (TCP/IP network). Every client, server and network
device must have a unique IP address for each network connection (network interface).
Every IP packet contains a source IP address and a destination IP address.

An IP network is somewhat similar to the telephone network in that you have to have
the phone number to reach a destination. The big difference is that IP addresses are
often temporary.

Each device in an IP network is either assigned a permanent address (static IP) by the
network administrator ar is assigned a temporary address (dynamic IP) via DHCP software.
Routers, firewalls and proxy servers use static addresses as do mast servers and printers
that serve multiple users. Client machines may use static or dynamic IP addresses. The
IP address assigned to your service by your cable or DSL Internet provider is typically
dynamic IP. In routers and operating systems, the default configuration for clients is
dynamic IP.

IP addresses are written in “dotted decimal” notation, which is four sets of numbers
separated by periods; for example, 204.171.64.2. If you knew the IP address of a Web
site, you could enter the dotted decimal number into your browser instead of the
domain name (which is why we have DNS!).

Although the next version of the IP protocol offers a virtually unlimited number of
unique addresses, the traditional IP address (IPv4) uses a 32-bit number that defines
both the network and the host computer. The network class determines how many of
the 32 bits are used for the network address, leaving the remaining bits for use as the
host humber (note the numbers of networks and hosts in the table below). The host
number can be further divided between subnetworks and hosts.
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Iterative-inductive research: The word iterative means ‘involving repetition’. Inductive
refers to application of logical validity. lterative-inductive research is a research that
applies scientific methods or processes, which are considered fundamental to scientific
investigation and acquisition of new knowledge based upon physical evidence by scientific
communities. Scientists use observations and reasoning to propose tentative explanations
for natural phenomena, termed hypotheses. Predictions from these hypotheses are
tested by various different experiments, and an hypothesis so verified is considered a
theory and new predictions are based upon it. Any erroneous predictions, internal
inconsistencies or lacunae, or unexplained phenomena initiate the generation of new
hypotheses, which are themselves tested, and so on. Any hypothesis which is cogent
enough to make predictions can be tested in this way.

Notably, an unverifieu hypothesis may gain considerable currency among specialists
based on its elegance or some intuitive sense of its validity or anticipation of its
verification, though it is not formally accepted until convincing experimental proof. An
example is the theory of general relativity.

The development of new technologies is enmeshed in the development of knowledge
according to the scientific method, and can serve both as a further test of the validity
of the underlying ideas and a source for new tools with which to advance the aquisition
of knowledge, by broadening the scope of the observable or improving the quality of
observations. Moreover, the need to understand or exploit some natural phenomenon
in developing a technology can motivate scientific inquiry into the nature of that
phenomenon.

A common viewpoint is to take scientific methods as the underlying logic of scientific
practices, e.g., Karl Popper. However, the emphasis on underlying logic is disputed by
those emphasising sociological aspects. Scientific methods are means used by scientific
communities for building supportable, evidence-based understandings of our natural
world. There is often controversy in scientific communities about various aspects of
these understandings.

Kurtosis: Kurtosis refers to the general form or a quantity indicative of the general form
of a statistical frequency curve near the mean of the distribution.

Legends: The word means an unverified story handed down from earlier times, especially
one popularly believed to be historical. It means also a body or collection of such
stories or a romanticized or popularised myth of modern times. It is also used for one
that inspires legends or achieves legendary fame. In the context of the unit in which
this word has occurred, it means an explanatory caption accompanying an illustration
of an explanatory table or list of the symbols appearing on a map or chart.

Logbook: The word means the official record book of a ship or an aircraft. In the
context of the unit in which this word has occurred, it means a record book with
periodic entries.

Lupus erythematosus: It refers to any of several connective tissue disorders, especially
systemic lupus erythematosus, that primarily affect women of childbearing age, have a
variety of clinical forms, and are characterized by red scaly skin lesions.

Metadata: It means the data that describes data. The term “metadata” is widely used to
refer to “data about data,”

Modus operandi: The phrase means a method of operating or functioning or it refers to
a person’s manner of working.

Monograph: The word refers to a scholarly piece of writing of essay or book length on
a specific, often limited subject. ’

Multivariate: It means having or involving more than one variable, for example, multivariate
statistical analysis.



Ndembu: Ndembu is the name of a Central African society of Zambia. Victor W. Turner
conducted extensive fieldwork among the Ndembu during 1950-1954.

Output: it means the act or process of producing; production and it refers to an
amount produced or manufactured during a certain time. For example, intellectual or
creative production can be described as literary output; artistic output. in Computer
Science the term refers to the information produced by a program or process from a
specific input.

As a verb it means to produce or manufacture (something) during a certain time.

Pane: It means a framed section of a window or door that is usually filled with a sheet of
glass or other transparent material or the transparent material used to fill such a section.

It refers also to a panel, as of a door or wall or one of the flat surfaces or facets of an
object, such as a bolt, having many sides.

Peer: The word refers to a person who has equal standirg with another or others, as in
rank, class, or age, for example, children who are easily influenced by their peers.

Pie charts: Pie charts are circular graphs having radii dividing the circle into sectors
proportional in angle and area to the relative size of the quantities represented. They
are also called circle graphs. Such charts are graphical representations of information
in which each unit of data is represented as a pie-shaped piece of a circle.

Precision: It refers to the quality or state of being precise or exact.

Prestroika: The term refers to the restructuring of the Soviet economy and bureaucracy
that began in the mid 1980s.

Primary data: The primary data is gathered through questionnaire, schedule, observation
or interview or by using two or more of these methods.

Questionnaire: This refers to a form containing a set of questions, especially one addressed
to a statistically significant number of subjects as a way of gathering information for a
survey.

Quixotic: It means being caught up in the romance of noble deeds and the pursuit of
unreachable goals; idealistic without regard to practicality.

Rapport: The term refers to the relationship, especially one of mutual trust or emotional
affinity.

Repeatability: It refers to the quality of making, doing, or performing again

Rabot: It is a mechanical device that sometimes resembles a human and is capable of
performing a variety of often complex human tasks on command or by being programmed
in-advance. This machine or device operates automatically or by remote control. The
term refers also to a person who works mechanically without original thought, especially
one who responds automatically to the commands of others.

Secondary data: Secondary data can be defined as previously gathered or gathered by
someone else. This data should be collected first and often such data will not answer all
questions. Such data evaluate the original study and data in terms of their purpose,
source, time period and method.

Skewness: It is a statistical term used to describe a situation’s asymmetry in relation to
a normal distribution. A positive skew describes a distribution favoring the right tail,
whereas a negative skew describes a distribution favoring the left tail.

Snowballing: It refers to causing to increase or multiply at a rapidly accelerating rate.

Spreadsheet: It refers to a piece of paper with rows and columns for recording financial
data for use in comparative analysis. In Computer Science it refers to an accounting or
bookkeeping program that displays data in rows and columns on a screen.

&

Glossary

181 &



Qualitative Methods
and Presentation of
Research Findings

+182¢

Structuralist model: in his Structuralist Model, Etzioni (1964) argues that Weber and
Marx together form the basis for the structural synthetic model. In this view, workers
and managers are inevitably in conflict, and all workers are alienated from their labour
{they don’t own the means of production). Control is central to the concept of
organisations. Etzioni sees the rational theorists like Weber contribute to this view by
focusing attention on the distribution of power among organizational positions. Natural
theorists like Barnard insist that power alienates unless the control structure is
acceptable to the subordinates. Etzioni also proposes that his structural model gives
equal weight to both formal and informal structures, social and material rewards, and
the interaction between the organization and its environment. Still, it acknowledges
the inevitable strains between management and workers, personal and corporate needs,
rationality and non-rationality, etc. (Scott p. 97). Overall, the structuralist view sees
both natural and rational systems as two sides of the same truth. They are in conflict
because the elements they describe are in conflict.

Subjectivity: Subjectivity refers to proceeding from or taking place in a person’s mind
rather than the external world, for example a subjective decision. in Psychology, it
refers that exists only within the experiencer’s mind. In Medicine, it relates to, or
designats a symptom or condition perceived by the patient and not by the examiner. it
also expresses or brings into prominence the individuality of the artist or author.

Swap: It means to trade one thing for another or to exchange (one thing) for another.

Symbolic interactionism: Symbolic interactionism is a sociological perspective which
examines how individuals and groups interact, focusing on the creation of personal
identity through interaction with others. Of particular interest is the relationship between
individual action and group pressures. This perspective examines the idea that subjective
meanings are socially constructed, and that these subjective meanings interrelate with
objective actions. Noted symbolic interactionists are Herbert Blumer and Erving Goffman.
George Herbert Mead is seen as a predecessor to symbolic interactionism.

Synchronic: Synchronic relates to the study of phenomena, such as linguistic features,
or of events of a particular time, without reference to their historical context.

Tabula rasa: The phrase refers to the state of the mind before it receives the impressions
gained from experience or to the unformed, featureless mind in the philosophy of John
Locke.

Transcripts: It refers to something transcribed, especially a written, typewritten, or
printed copy, for example the transcript of court testimony; an academic transcript. In

Biology it refers a sequence of RNA produced by transcription.

Triangulation: It refers to the measurement of the elements necessary to determine
the network of triangles into which any part of the earth’s surface is divided in surveying.
This method has been used in sociology for finding a position by means of bearings from
two fixed points a known distance apart.

T-test: It means student’s t-test. A t-test is any statistical hypothesis test in which the
test statistic has a Student’s t-distribution if the null hypothesis is true.

- A statistical test of the null hypothesis is that the means of two normally distributed

populations are equal. All such tests are usually referred to as Student’s t-tests,
though strictly speaking that name should only be used if the variances of the two
populations are also assumed to be equal; the form of the test used when this
assumption is dropped is sometimes called Welch’s t-test. There are different versions
of the t-test depending on whether the two samples are independent of each other
(e.g., individuals randomly assigned into two groups), or paired, so that each member
of one sample has a unique relationship with a particular member of the other sample
(e.g., the same people measured before and after an intervention, or IQ test scores of
a husband and wife).



w

If the t value that is calculated is greater than the threshold chosen for statistical
significance (alpha conventionally equal to 0.05), then the null hypothesis that the two

~ groups do not differ is rejected in favour of the alternative hypothesis, which typically

states that the groups do differ.

Twice-blessed: Blessed means enjoying happiness and twice-blessed is the same in a
heightened manner.

Univariate: it means having one variable. *
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